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Executive Summary 1 

 Data integrity attacks have compromised corporate information including emails, employee 2 
records, financial records, and customer data. 3 

 Destructive malware, ransomware, malicious insider activity, and even honest mistakes all set 4 
the stage for why organizations need to quickly recover from an event that alters or destroys 5 
data. Businesses must be confident that recovered data is accurate and safe. 6 

 The National Cybersecurity Center of Excellence (NCCoE) at NIST built a laboratory environment 7 
to explore methods to effectively recover from a data corruption event in various Information 8 
Technology (IT) enterprise environments. NCCoE also explored auditing and reporting IT system 9 
use issues to support incident recovery and investigations. 10 

 This NIST Cybersecurity Practice Guide demonstrates how organizations can develop and 11 
implement appropriate actions following a detected cybersecurity event. The solutions outlined 12 
in this guide encourage monitoring and detecting data corruption in commodity components—13 
as well as custom applications and data composed of open-source and commercially available 14 
components. 15 

 Thorough quantitative and qualitative data collection is important to organizations of all types 16 
and sizes. It can impact all aspects of a business including decision making, transactions, 17 
research, performance, and profitability, to name a few. 18 

CHALLENGE 19 

Organizations must be able to quickly recover from a data integrity attack and trust that any recovered 20 
data is accurate, complete, and free of malware. Data integrity attacks caused by unauthorized 21 
insertion, deletion, or modification of data have compromised corporate information including emails, 22 
employee records, financial records, and customer data. Some organizations have experienced systemic 23 
attacks that caused a temporary cessation of operations. One variant of a data integrity attack–24 
ransomware–encrypts data and holds it hostage while the attacker demands payment for the 25 
decryption keys.  26 

SOLUTION 27 

The NCCoE developed and implemented a solution that incorporates  appropriate actions in response to 28 
a detected cybersecurity event. If data integrity is jeopardized, multiple systems work in concert to 29 
recover from the event. The solution includes recommendations for commodity components and 30 
explores issues around auditing and reporting to support recovery and investigations. 31 

While the NCCoE used a suite of commercial products to address this cybersecurity challenge, this guide 32 
does not endorse any particular products—nor does it guarantee compliance with any regulatory 33 
initiatives. Your organization's information security experts are responsible for identifying the available 34 
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products that will best integrate with your existing tools and IT system infrastructure. Your organization 35 
can choose to adopt this solution or one that adheres to these suggested guidelines or you can use this 36 
guide as a starting point for tailoring and implementing parts of the solution. 37 

BENEFITS  38 

This practice guide can help your organization: 39 

 develop a strategy for recovering from a cybersecurity event 40 

 facilitate a smoother recovery from an adverse event, maintain operations, and ensure the 41 
integrity and availability of data critical to supporting business operations and revenue-42 
generating activities 43 

 manage enterprise risk (consistent with foundations of the NIST Framework for Improving 44 
Critical Infrastructure Cybersecurity) 45 

SHARE YOUR FEEDBACK 46 

You can view or download the Practice Guide at 47 
https://nccoe.nist.gov/projects/building_blocks/data_integrity. 48 

Help the NCCoE make this guide better by sharing your thoughts with us as you read the guide. If you 49 
adopt this solution for your own organization, please share your experience and advice with us. We 50 
recognize that technical solutions alone will not fully enable the benefits of our solution, so we 51 
encourage organizations to share lessons learned and best practices for transforming the processes 52 
associated with implementing this guide. 53 

To provide comments or to learn more by arranging an in-person demonstration of this reference 54 
solution, email the project team at di-nccoe@nist.gov. 55 

TECHNOLOGY PARTNERS/COLLABORATORS 56 

Organizations participating in this project submitted their capabilities in response to an open call in the 57 
Federal Register for all sources of relevant security capabilities from academia and industry (vendors 58 
and integrators). The following respondents with relevant capabilities or product components (identified 59 
as “Technology Partners/Collaborators” herein) signed a Cooperative Research and Development 60 
Agreement to collaborate with NIST in a consortium to build this example solution. 61 

 62 

Certain commercial entities, equipment, products, or materials may be identified by name or company 63 
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an 64 
experimental procedure or concept adequately. Such identification is not intended to imply special 65 
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it 66 

https://nccoe.nist.gov/projects/building_blocks/data_integrity
mailto:di-nccoe@nist.gov?subject=Join%20Community%20of%20Interest
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The National Cybersecurity Center of Excellence (NCCoE), a part of the National 
Institute of Standards and Technology (NIST), is a collaborative hub where industry 
organizations, government agencies, and academic institutions work together to 
address businesses’ most pressing cybersecurity challenges. Through this 
collaboration, the NCCoE develops modular, easily adaptable example cybersecurity 
solutions demonstrating how to apply standards and best practices using 
commercially available technology. 

 LEARN MORE  
Visit https://nccoe.nist.gov  
nccoe@nist.gov  
301-975-0200 
 

 

intended to imply that the entities, equipment, products, or materials are necessarily the best available 67 
for the purpose. 68 

  

https://nccoe.nist.gov/
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DISCLAIMER 
Certain commercial entities, equipment, products, or materials may be identified in this document in 
order to describe an experimental procedure or concept adequately. Such identification is not intended 
to imply recommendation or endorsement by NIST or NCCoE, nor is it intended to imply that the 
entities, equipment, products, or materials are necessarily the best available for the purpose. 
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 1 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 2 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 3 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 4 
public-private partnership enables the creation of practical cybersecurity solutions for specific 5 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 6 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 7 
Fortune 50 market leaders to smaller companies specializing in IT security—the NCCoE applies standards 8 
and best practices to develop modular, easily adaptable example cybersecurity solutions using 9 
commercially available technology. The NCCoE documents these example solutions in the NIST Special 10 
Publication 1800 series, which maps capabilities to the NIST Cyber Security Framework and details the 11 
steps needed for another entity to recreate the example solution. The NCCoE was established in 2012 by 12 
NIST in partnership with the State of Maryland and Montgomery County, Md. 13 

To learn more about the NCCoE, visit https://nccoe.nist.gov. To learn more about NIST, visit 14 
https://www.nist.gov. 15 

NIST CYBERSECURITY PRACTICE GUIDES 16 

NIST Cybersecurity Practice Guides (Special Publication Series 1800) target specific cybersecurity 17 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 18 
adoption of standards-based approaches to cybersecurity. They show members of the information 19 
security community how to implement example solutions that help them align more easily with relevant 20 
standards and best practices and provide users with the materials lists, configuration files, and other 21 
information they need to implement a similar approach. 22 

The documents in this series describe example implementations of cybersecurity practices that 23 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 24 
or mandatory practices, nor do they carry statutory authority.  25 

ABSTRACT 26 

Businesses face a near-constant threat of destructive malware, ransomware, malicious insider activities, 27 
and even honest mistakes that can alter or destroy critical data. These data corruption events could 28 
cause a significant loss to a company’s reputation, business operations, and bottom line.   29 

These types of adverse events, that ultimately impact data integrity, can compromise critical corporate 30 
information including emails, employee records, financial records, and customer data. It is imperative 31 
for organizations to recover quickly from a data integrity attack and trust the accuracy and precision of 32 
the recovered data. 33 

https://nccoe.nist.gov/
https://www.nist.gov/
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The National Cybersecurity Center of Excellence (NCCoE) at NIST built a laboratory environment to 34 
explore methods to effectively recover from a data corruption event in various Information Technology 35 
(IT) enterprise environments. NCCoE also implemented auditing and reporting IT system use to support 36 
incident recovery and investigations.  37 

This NIST Cybersecurity Practice Guide demonstrates how organizations can implement technologies to 38 
take immediate action following a data corruption event. The example solution outlined in this guide 39 
encourages effective monitoring and detection of data corruption in standard, enterprise components 40 
as well as custom applications and data composed of open-source and commercially available 41 
components. 42 

KEYWORDS 43 

business continuity; data integrity; data recovery; malware; ransomware 44 
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1 Summary 127 

Businesses face a near-constant threat of destructive malware, ransomware, malicious insider activities, 128 
and even honest mistakes that can alter or destroy critical data. These types of adverse events 129 
ultimately impact data integrity (DI). It is imperative for organizations to recover quickly from a DI attack 130 
and trust the accuracy and precision of the recovered data. 131 

The National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards and 132 
Technology (NIST) built a laboratory environment to explore methods to recover from a data corruption 133 
event in various information technology (IT) enterprise environments. The example solution outlined in 134 
this guide describes the solution built in the NCCoE lab. It encourages effective monitoring and detection 135 
of data corruption in standard enterprise components as well as custom applications and data 136 
composed of open-source and commercially available components. 137 

The goals of this NIST Cybersecurity Practice Guide are to help organizations confidently:  138 

 restore data to its last known good configuration 139 

 identify the correct backup version (free of malicious code and data for data restoration) 140 

 identify altered data as well as the date and time of alteration 141 

 determine the identity/identities of those who alter data 142 

 identify other events that coincide with data alteration 143 

 determine any impact of the data alteration 144 

For ease of use, here is a short description of the different sections of this volume. 145 

 Section 1: Summary presents the challenge addressed by the NCCoE project, with an in-depth 146 
look at our approach, the architecture, and the security characteristics we used; the solution 147 
demonstrated to address the challenge; benefits of the solution; and the technology partners 148 
that participated in building, demonstrating, and documenting the solution. The Summary also 149 
explains how to provide feedback on this guide.  150 

 Section 2: How to Use This Guide explains how readers—business decision makers, program 151 
managers, and IT professionals (e.g., systems administrators)—might use each volume of the 152 
guide.  153 

 Section 3: Approach offers a detailed treatment of the scope of the project and describes the 154 
assumptions on which the security platform development was based, the risk assessment that 155 
informed platform development, and the technologies and components that industry 156 
collaborators gave us to enable platform development.  157 
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 Section 4: Architecture describes the usage scenarios supported by project security platforms, 158 
including Cybersecurity Framework [1] functions supported by each component contributed by 159 
our collaborators.  160 

 Section 5: Example Implementation provides an in-depth description of the implementation 161 
developed in the NCCoE’s lab environment. 162 

 Section 6: Security Characteristics Analysis provides details about the tools and techniques we 163 
used to perform risk assessments.  164 

 Section 7: Functional Evaluation summarizes the test sequences we employed to demonstrate 165 
security platform services, the Cybersecurity Framework functions to which each test sequence 166 
is relevant, and the NIST Special Publication (SP) 800-53-4 controls that applied to the functions 167 
being demonstrated.  168 

 Section 8: Future Build Considerations is a brief treatment of other DI implementations NIST is 169 
considering consistent with Framework Core Functions: Identify, Protect, Detect and Respond, 170 
System Level Recovery, and Dashboarding. 171 

1.1 Challenge 172 

Thorough collection of quantitative and qualitative data is important to organizations of all types and 173 
sizes. It can impact all aspects of a business, including decision making, transactions, research, 174 
performance, and profitability. When these data collections sustain a DI attack caused by unauthorized 175 
insertion, deletion, or modification of information, it can impact emails, employee records, financial 176 
records, and customer data, rendering it unusable or unreliable. Some organizations have experienced 177 
systemic attacks that caused a temporary cessation of operations. One variant of a DI attack—178 
ransomware—encrypts data and holds it hostage while the attacker demands payment for the 179 
decryption keys.  180 

When DI events occur, organizations must be able to recover quickly from the events and trust that the 181 
recovered data is accurate, complete, and free of malware. 182 

1.2 Solutions  183 

The NCCoE implemented a solution that incorporates appropriate actions in response to a detected DI 184 
event. The solution is comprised of multiple systems working together to recover from a data corruption 185 
event in standard enterprise components. These components include, but are not limited to, mail 186 
servers, databases, end user machines, virtual infrastructure, and file share servers. Essential to the 187 
recovery is an investigation into auditing and reporting records to understand the depth and breadth of 188 
the event across these systems and inclusive of user activity.  189 

The NCCoE sought existing technologies that provided the following capabilities: 190 
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 secure storage 191 

 logging 192 

 virtual infrastructure 193 

 corruption testing 194 

 backup capability 195 

While the NCCoE used a suite of commercial products to address this cybersecurity challenge, this guide 196 
does not endorse any particular products—nor does it guarantee compliance with any regulatory 197 
initiatives. Your organization’s information security experts should identify the products that will best 198 
integrate with your existing tools and IT system infrastructure. Your organization can adopt this solution 199 
or one that adheres to these guidelines in whole, or you can use this guide as a starting point for 200 
tailoring and implementing parts of the solution. In developing our solution, we used standards and 201 
guidance from the following, which can also provide your organization relevant standards and best 202 
practices: 203 

 NIST Framework for Improving Critical Infrastructure Cybersecurity (commonly known as the 204 
NIST CSF) [1] 205 

 NISTIR 8050: Executive Technical Workshop on Improving Cybersecurity and Consumer Privacy 206 
[2] 207 

 Special Publication 800-30 Rev. 1: Guide for Conducting Risk Assessments [3] 208 

 Special Publication 800-37 Rev. 1: Guide for Applying the Risk Management Framework to 209 
Federal Information Systems: A Security Lifecycle Approach [4] 210 

 Special Publication 800-39: Managing Information Security Risk [5] 211 

 Special Publication 800-40 Rev. 3: Guide to Enterprise Patch Management Technologies [6] 212 

 Special Publication 800-53 Rev. 4: Security and Privacy Controls for Federal Information Systems 213 
and Organizations [7] 214 

 FIPS 140-2: Security Requirements for Cryptographic Modules [8] 215 

 Special Publication 800-86: Guide to Integrating Forensic Techniques into Incident Response [9] 216 

 Special Publication 800-92: Guide to Computer Security Log Management [10] 217 

 Special Publication 800-100: Information Security Handbook: A Guide for Managers [11] 218 

 Special Publication 800-34 Rev. 1: Contingency Planning Guide for Federal Information Systems 219 
[12] 220 

 Office of Management and Budget, Circular Number A-130: Managing Information as a Strategic 221 
Resource [13] 222 
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 Special Publication 800-61 Rev. 2: Computer Security Incident Handling Guide [14] 223 

 Special Publication 800-83 Rev. 1: Guide to Malware Incident Prevention and Handling for 224 
Desktops and Laptops [15] 225 

 Special Publication 800-150: Guide to Cyber Threat Information Sharing [16] 226 

 Special Publication 800-184: Guide for Cybersecurity Event Recovery [17] 227 

1.3 Benefits 228 

The NCCoE’s practice guide can help your organization: 229 

 develop an implementation plan for recovering from a cybersecurity event 230 

 facilitate a smoother recovery from an adverse event and maintain operations 231 

 maintain integrity and availability of data that is critical to supporting business operations and 232 
revenue-generating activities 233 

 manage enterprise risk (consistent with the foundations of the NIST CSF) 234 

2 How to Use This Guide 235 

This NIST Cybersecurity Practice Guide demonstrates a standards-based reference design and provides 236 
users with the information they need to replicate a solution to recover from attacks on DI to a last 237 
known good. This reference design is modular and can be deployed in whole or in part. 238 

This guide contains three volumes: 239 

 NIST SP 1800-11a: Executive Summary 240 

 NIST SP 1800-11b: Approach, Architecture, and Security Characteristics – what we built and why 241 
(you are here) 242 

 NIST SP 1800-11c: How-To Guides – instructions for building the example solution 243 

Depending on your role in your organization, you might use this guide in different ways. 244 

Business decision makers, including chief security and technology officers, will be interested in the 245 
Executive Summary (NIST SP 1800-11a), which describes the: 246 

 challenges enterprises face in attacks on DI 247 

 example solution built at the NCCoE 248 

 benefits of adopting the example solution 249 



DRAFT 

NIST SP 1800-11B: Data Integrity 5 

Technology or security program managers who are concerned with how to identify, understand, assess, 250 
and mitigate risk will be interested in this part of the guide, NIST SP 1800-11b, which describes what we 251 
did and why. The following sections will be of particular interest: 252 

 Section 3.4.1, Assessing Risk Posture - describes the risk analysis we performed. 253 

 Section 3.4.2, Security Control Map - maps the security characteristics of this example solution 254 
to cybersecurity standards and best practices. 255 

You might share the Executive Summary, NIST SP 1800-11a, with your leadership team members to help 256 
them understand the importance of adopting standards-based methods to recover from attacks on DI to 257 
a last known good. 258 

IT professionals who want to implement a similar approach will find the whole practice guide useful. 259 
You can use the “how-to” portion of the guide, NIST SP 1800-11c, to replicate all or parts of the build 260 
created in our lab. The guide provides specific product installation, configuration, and integration 261 
instructions. We do not recreate the product manufacturers’ documentation, which is generally widely 262 
available. Rather, we show how we incorporated the products together in our environment to create an 263 
example solution. 264 

This guide assumes that IT professionals have experience implementing security products within the 265 
enterprise. While we used a suite of commercial products, this guide does not endorse these particular 266 
products. Your organization can adopt this solution or one that adheres to these guidelines in whole, or 267 
you can use this guide as a starting point for tailoring parts of it to recover from attacks on DI. Your 268 
organization’s security experts should identify the products that will best integrate with your existing 269 
tools and IT system infrastructure. We hope you will seek products that are congruent with applicable 270 
standards and best practices. Section 3.5, Technologies, lists the products we used and maps them to 271 
the cybersecurity controls provided by this reference solution. 272 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 273 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 274 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to  275 
di-nccoe@nist.gov.  276 

mailto:di-nccoe@nist.gov
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2.1 Typographic Conventions 277 

The following table presents typographic conventions used in this volume. 278 

Typeface/ Symbol Meaning Example 

Italics filenames and pathnames 
references to documents that 
are not hyperlinks, new terms, 
and placeholders 

For detailed definitions of terms, 
see the NCCoE Glossary. 

Bold names of menus, options, 
command buttons and fields 

Choose File > Edit. 

Monospace command-line input, on-
screen computer output, 
sample code examples, status 
codes 

mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the 
document, a web URL, or an 
email address 

All publications from NIST’s National 
Cybersecurity Center of Excellence 
are available at 
http://nccoe.nist.gov 

3 Approach 279 

Based on key points expressed in NIST IR 8050: Executive Technical Workshop on Improving 280 
Cybersecurity and Consumer Privacy (2015) [2], the NCCoE is pursuing a series of DI projects to map the 281 
core functions of the NIST Cybersecurity Framework. This initial project is centered on the core function 282 
of recovery, which is focused on recovering data to the last known good state. NCCoE engineers working 283 
with a Community of Interest (COI) defined the requirements for the DI project.  284 

Members of the COI, which include participating vendors referenced in this document, contributed to 285 
the development of the architecture and reference design, providing technologies that meet the project 286 
requirements and assisting in the installation and configuration of those technologies. The practice 287 
guide highlights the approach used to develop the NCCoE reference solution. Elements include risk 288 
assessment and analysis, logical design, build development, test and evaluation, and security control 289 

http://nccoe.nist.gov/
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mapping. This guide is intended to provide practical guidance to any organization interested in 290 
implementing a solution for recovery from a cybersecurity event. 291 

3.1 Audience 292 

This guide is intended for individuals responsible for implementing security solutions in organizations’ IT 293 
support activities. Current IT systems, particularly in the private sector, often lack integrity protection 294 
for domain name services and electronic mail. The platforms demonstrated by this project, and the 295 
implementation information provided in these practice guides, permit integration of products to 296 
implement a data recovery system. The technical components will appeal to system administrators, IT 297 
managers, IT security managers, and others directly involved in the secure and safe operation of the 298 
business IT networks.  299 

3.2 Scope 300 

The guide provides practical, real-world guidance on developing and implementing a DI solution 301 
consistent with the principles in the NIST Framework for Improving Critical Infrastructure Cybersecurity 302 
Volume 1 [1], specifically the core function of recover. Recover emphasizes developing and 303 
implementing the appropriate activities to maintain plans for resilience and to restore any capabilities or 304 
services that were impaired by a cybersecurity event to a last known good state. Examples of outcomes 305 
within this function include recovery planning, improvements, and communication.  306 

3.3 Assumptions 307 

This project is guided by the following assumptions: 308 

 The solution was developed in a lab environment. The environment is based on a typical 309 
organization’s IT enterprise. It does not reflect the complexity of a production environment.  310 

 An organization has access to the skill sets and resources required to implement a data recovery 311 
solution. 312 

 A DI event has taken place and been detected. This guide does not address the actual detection 313 
function.  314 

3.4 Risk Assessment 315 

NIST SP 800-30 Rev. 1: Guide for Conducting Risk Assessments [3] states that the definition of risk is “a 316 
measure of the extent to which an entity is threatened by a potential circumstance or event, and 317 
typically a function of: (i) the adverse impacts that would arise if the circumstance or event occurs; and 318 
(ii) the likelihood of occurrence.” The NCCoE recommends that any discussion of risk management, 319 
particularly at the enterprise level, begin with a comprehensive review of NIST 800-37: A Guide for 320 
Applying the Risk Management Framework to Federal Information Systems [4]. The framework proved 321 
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invaluable in giving us a baseline to assess risks, from which we developed the required security controls 322 
of the reference design and this guide.  323 

We performed two types of risk assessment:  324 

 Initial analysis of the risk factors that were discussed with financial, retail, and hospitality 325 
institutions. This analysis led to the creation of the DI project and the desired security posture. 326 
See NIST IR 8050 Executive Technical Workshop [2] for additional participant information. 327 

 Analysis of how to secure the components within the solution and minimize any vulnerabilities 328 
they might introduce. See Section 6, Security Characteristics Analysis. 329 

3.4.1 Assessing Risk Posture 330 
Using the guidance in NIST’s series of publications concerning risk, we worked with financial institutions 331 
and the Financial Sector Information Sharing and Analysis Center to identify the most compelling risk 332 
factors encountered by this business group. We participated in conferences and met with members of 333 
the financial sector to define the main security risks to business operations. These discussions resulted 334 
in the identification of an area of concern—the inability to recover from DI attacks. We then identified 335 
the core operational risks, as various methods exist that all lead to sustaining a DI compromise. These 336 
risks lead to two tactical risk factors:  337 

 systems incapacitated 338 

 DI impacted  339 

These discussions also gave us an understanding of strategic risks for organizations with respect to DI. 340 
NIST SP 800-39: Managing Information Security Risk [5] focuses particularly on the business aspect of 341 
risk, namely at the enterprise level. This understanding is essential for any further risk analysis, risk 342 
response/mitigation, and risk monitoring activities. The following is a summary of the strategic risk areas 343 
we identified and their mitigations:  344 

 Impact on system function – ensuring the availability of accurate data or sustaining an 345 
acceptable level of DI reduces the risk of systems’ availability being compromised.  346 

 Cost of implementation – implementing DI once and using it across all systems may reduce both 347 
system restoration and system continuity costs.  348 

 Compliance with existing industry standards – contributes to the industry requirement to 349 
maintain a continuity of operations plan.  350 

 Maintenance of reputation and public image – helps reduce level of impact, in turn helping to 351 
maintain image.  352 

 Increased focus on DI – includes not just loss of confidentiality but also harm from unauthorized 353 
alteration of data (per NIST IR 8050 [2]).  354 
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We subsequently translated the risk factors identified to security functions and subcategories within the 355 
NIST CSF. In Table 3-1 we mapped the categories to NIST’s SP 800-53 Rev. 4 [7] controls and 356 
International Electrotechnical Commission/International Organization for Standardization (IEC/ISO) 357 
controls for additional guidance. 358 

3.4.2 Security Control Map 359 
As explained in Section 3.4.1, we identified the CSF security functions and subcategories that we wanted 360 
the reference design to support through a risk analysis process. This was a critical first step in designing 361 
the reference design and example implementation to mitigate the risk factors. Table 3-1 lists the 362 
addressed CSF functions and subcategories and maps them to relevant NIST standards, industry 363 
standards, and controls and best practices. The references provide solution validation points in that they 364 
list specific security capabilities that a solution addressing the CSF subcategories would be expected to 365 
exhibit. Organizations can use Table 3-1 to identify the CSF subcategories and NIST 800-53 controls that 366 
they are interested in addressing. 367 

Note: Not all the CSF subcategories guidance can be implemented using technology. Any organization 368 
executing a DI solution would need to adopt processes and organizational policies that support the 369 
reference design. For example, some of the subcategories within the CSF function “Identify” are 370 
processes and policies that should be developed prior to implementing recommendations. 371 

Table 3-1 Data Integrity Reference Design CSF Core Components Map 372 

Cybersecurity Framework (CSF) v1.1 Standards & Best Practices 
Function Category Subcategory SP800-53R4 ISO/IEC 27001:2013 

PROTECT (PR) Data 
Security 
(PR.DS) 

PR.DS-1: Data-at-
rest is protected 

SC-28 A.8.2.3

PR.DS-6: Integrity 
checking 
mechanisms are 
used to verify 
software, 
firmware, and 
information 
integrity 

SI-7 A.12.2.1, A.12.5.1, A.14.1.2,
A.14.1.3
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Cybersecurity	Framework	(CSF)	v1.1	 Standards & Best Practices 
Function	 Category	 Subcategory	 SP800-53R4	 ISO/IEC	27001:2013	

Information	

Protection	

Processes	

and	

Procedures	

(PR.IP)	

PR.IP-3:	

Configuration	

change	control	

processes	are	in	

place	

CM-3,	CM-4,

SA-10

A.12.1.2,	A.12.5.1,	A.12.6.2,

A.14.2.2,	A.14.2.3,	A.14.2.4,

A.14.2.7

PR.IP-4:	Backups	

of	information	

are	conducted,	

maintained,	and	

tested	

periodically	

CP-4,	CP-6,	

CP-9	

A.11.1.4,	A.12.3.1,

A.17.1.2,	A.17.1.3,	A.17.2.1	A.

18.1.3

PR.IP-9:	

Response	plans	

(Incident	

Response	and	

Business	

Continuity)	and	

recovery	plans	

(Incident	

Recovery	and	

Disaster	

Recovery)	are	in	

place	and	

managed	

CP-2,	IR-8	 A.16.1.1,	A.17.1.1,	A.17.1.2,
A.17.2.1

Protective	

Technology	

(PR.PT)		

PR.PT-1:	

Audit/log	records	

are	determined,	

documented,	

implemented,	

and	reviewed	in	

accordance	with	

policy	

AU	Family	IR-

5,	IR-6	

A.6.1.3,	A.16.1.2,	A.12.4.1,

A.12.4.2,	A.12.4.3,	A.12.4.4,

A.12.7.1
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Cybersecurity Framework (CSF) v1.1 Standards & Best Practices 
Function Category Subcategory SP800-53R4 ISO/IEC 27001:2013 

DETECT (DE) Anomalies 
and Events 
(DE.AE) 

DE.AE-4: Impact 
of events is 
determined 

CP-2, IR-4, RA-
3, SI -4 

A.6.1.1, A.17.1.1, 
A.17.2.1, A.16.1.4, A.16.1.5, 
A.16.1.6, A.12.6.1  

Security 
Continuous 
Monitoring 
(DE.CM) 

DE.CM-1: The 
network is 
monitored to 
detect potential 
cybersecurity 
events 

AC-2, AU-12, 
CA-7, CM-3, 
SC-5, SC-7, SI-
4 

A.9.2.1, A.9.2.2, A.9.2.3, 
A.9.2.5, A.9.2.6, A.12.4.1, 
A.12.4.3, A.12.1.2, A.14.2.2, 
A.14.2.3, A.14.2.4, A.13.1.1, 
A.13.1.3, A.13.2.1, A.14.1.3  

DE.CM-3: 
Personnel 
activity is 
monitored to 
detect potential 
cybersecurity 
events 

AC-2, AU-12, 
AU-13, CA-7, 
CM-10, CM-11 

A.9.2.1, A.9.2.2, A.9.2.3, 
A.9.2.5, A.9.2.6, A.12.4.1, 
A.12.4.3, A.18.1.2, A.12.5.1, 
A.12.6.2s  

3.5 Technologies 373 

Table 3-2 lists all the technologies used in this project and provides a mapping between the generic 374 
application term, the specific product used, and the security control(s) that the product provides. Refer 375 
to Table 3-1 for an explanation of the CSF subcategory codes. This table describes only the product 376 
capabilities used in our example solution. Many of the products have additional security capabilities that 377 
were not used for our purposes.378 
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Table 3-2 Products and Technologies 379 

Component Specific Product Function CSF  
Subcategories 

Corruption 
Testing 

ArcSight Enterprise 
Security Manager (ESM) 
v6.9.1 

• provides monitoring for changes 
to data on a system 
• provides logs, detection, and 
reporting, in the event of changes to 
data on a system 
• provides audit capabilities for 
database metadata and content 
modifications 
• provides file hashing and integrity 
testing independent of file type (can 
include software files) 
• provides notifications for changes 
to configuration 
• provides file monitoring for 
cybersecurity events 
• provides analytic capabilities to 
determine the impact of integrity 
events 

PR.DS-6, PR.PT-1, 
DE.AE-4 

Tripwire Enterprise v8.5 

Tripwire Log Center 
Manager v7.2.4.80 

Secure Storage Spectrum Protect and 
Backup and Replication 
v8.1.0 

• provides write-once read-many 
file disk storage for secure backups 
of integrity information 
• provides immutability of backups 
• creates encrypted backups 

PR.DS-1, 
PR.IP-4 

WORMdisk v151228 

Logging ArcSight Enterprise 
Security Manager (ESM) 
v6.9.1 

• provides auditing and logging 
capabilities configurable to 
corporate policy 
• provides logging of some user 
activity of monitored systems 

PR.PT-1, 
DE.AE-4, DE.CM-
1, DE.CM-3 
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Component Specific Product Function CSF  
Subcategories 

Tripwire Enterprise v8.5 • provides network information 
about certain cybersecurity events 
• correlates logs of cybersecurity 
events with user information 
• provides logs of database activity 
and database backup operations 
• provides analysis capabilities for 
log data 
• provides analysis capabilities for 
finding anomalies in user activity  
• provides automation for logging 
• provides logs of database activity 
and database backup operations 

Tripwire Log Center 
Manager v7.2.4.80 

Backup 
Capability 

Spectrum Protect and 
Backup and Replication 
v8.1.0 

• provides backup and restoration 
capabilities for systems 
• provides backup and restore 
capabilities for configuration files 
• provides immutable storage 
• performs periodic backups of 
information 

PR.DS-1,  
PR.IP-3, 
PR.IP-4, 
PR.IP-9 WORMdisk v151228 

Virtual  
Infrastructure 

Veeam Availability Suite 
9.5 

• provides backup and restoration 
capabilities for virtual systems 
• provides ability to encrypt 
backups 
• provides logs for backup and 
restore operations 

PR.DS-1, 
PR.IP-4, 
PR.PT-1 

380 
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4 Architecture 381 

Data integrity involves the recovery of data after a ransomware or other destructive attack with the 382 
validation that the recovered data is the last known good. This section presents a high-level architecture 383 
and reference design for implementing such a solution.  384 

4.1 Architecture Description 385 

4.1.1 High-Level Architecture 386 
The DI solution is designed to address the security functions and subcategories described in Table 3-1 387 
and is composed of the capabilities illustrated in Figure 4-1.  388 

Figure 4-1 DI High-Level Architecture 389 

 390 

1. Secure Storage provides the capability to store data with additional data protection measures, 391 
such as Write Once Read Many (WORM) technologies or data encryption.  392 

2. Logging stores and reports all the log files produced by the components within the enterprise.  393 

3. Virtual Infrastructure provides virtualized capabilities, including backup capabilities for the 394 
virtual infrastructure. 395 

4. Corruption Testing provides capabilities for testing file corruption and provides notification or 396 
logs of violations against specified policies. 397 

5. Backup Capability establishes a capability for components within the enterprise that are not a 398 
part of the virtual infrastructure to produce a backup. 399 

These capabilities work together to provide the recover function for DI. The secure storage is the ability 400 
to store file-such as backups, gold images, or configurations files, in a format that cannot be corrupted, 401 
since files cannot be altered or changed while in storage. The logging capability works in conjunction 402 
with the corruption testing. The corruption testing capability describes the event(s) when the attack 403 
occurs and the damage caused. Since the corruption testing describes when the event occurred, these 404 
details can be used to investigate the logs to correlate all events relative to the attack across all items 405 
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that report log files. After the last known good is determined via the logs and corruption testing, the 406 
backup capability for either the enterprise or the virtual infrastructure is employed. A backup capability 407 
is the ability to restore to the point prior to the DI event. The backup capability is supplemented by built-408 
in backup and rollback capabilities of the database services.  409 

The following components of the high-level architecture are not addressed in this guide: enterprise 410 
components (e.g., virtual machines, mail servers, active directory, file sharing capabilities), installation 411 
and configurations, file corruption testing policies, and event detection.  412 

4.1.2 Reference Design 413 
The reference design addresses the DI architecture in conjunction with its interactions with a 414 
representation of a basic enterprise.  415 

Figure 4-2 DI Reference Design 416 

 417 

Solid lines represent the communication of information between components within the enterprise, 418 
from the enterprise to the DI architecture, or between components within the DI architecture. The lines 419 
are color coded to correspond with the capability provided by the DI architecture.  420 

The Secure Storage component provides a capability to store the most critical files for an enterprise. 421 
These would include backup data, configuration files, and golden images. Additional measures need to 422 
be applied to provide increased security to these files so they are not subject to attacks or corruption.  423 
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The Corruption Testing component provides the ability to test, understand, and measure the attack that 424 
occurred to files and components within the enterprise. This testing is essential to identify the last 425 
known good for the DI recovery process. For these measures to be applicable to an enterprise, 426 
appropriate triggers need to be defined and developed within the capability that look for specific events. 427 
For example, it may be very normal for end users to have encrypted files they develop during 428 
operational hours. But if every file on the end user’s workstation begins to be encrypted, or an 429 
encryption begins to happen on the end user machine at hours outside of normal operational hours, 430 
these could be identifiable actions noted in the log files indicating a ransomware attack. For an 431 
enterprise, these triggers need to be defined appropriately and thoroughly to have a successful 432 
Corruption Testing capability.  433 

The Backup Capability component supports the ability to back up each component within the enterprise 434 
as well as perform a restore that uses backup data. The configuration of this component needs to align 435 
with the tempo of the enterprise. For example, if an enterprise is performing thousands of transactions 436 
per hour per day, then a backup solution that only performs a backup once a day would not adequately 437 
provide for the enterprise. This type of configuration would allow for a potentially large data loss. If 438 
backups occur every morning and a loss of DI happened at the end of the day, then a full day’s worth of 439 
transactions would be lost. The decision on what the correct configuration is determined by an 440 
organization’s risk tolerance. More information pertaining to this decision can be found in Section 441 
5.1.1.3. 442 

The Virtual Infrastructure component straddles the line between being part of the enterprise and part of 443 
the DI architecture. It provides virtual capabilities to the enterprise as well as backup and restoration 444 
capabilities to support the DI architecture. The backup and restoration capabilities are for the virtual 445 
infrastructure itself. For data that is produced on individual virtual machines (VMs), either the VM 446 
infrastructure can provide the file-level restoration or the backup component can provide this capability. 447 
If the VM infrastructure cannot provide its own backup and restoration, then the requirements for that 448 
are levied on the backup component.  449 

Logging from each component and sorting the logs together is imperative to understanding the 450 
ramifications of the attack across the enterprise. File, system, and configuration changes and 451 
modifications need to be logged, reported, and stored in one repository where events can be identified 452 
and understood.  453 

Databases are necessary to support everyday operations of the enterprise architecture and to assist in 454 
backup and recovery. The chosen database software should have built-in backup and rollback methods 455 
enabled, although commercial solutions for the backup and recovery of databases exist. Often, these 456 
commercial solutions use the internal database backup/recovery capabilities. These capabilities are tied 457 
into the security architecture, as demonstrated in Section 5.1.6.2. Consult the Backup Capability 458 
paragraph above for guidance on the regularity of backups. The regularity of database backups 459 
determines the effectiveness of data recovery efforts.  460 
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5 Example Implementation 461 

The example implementation is constructed on the NCCoE lab’s infrastructure, which consists of a 462 
VMware vSphere virtualization operating environment. We used network attached storage and virtual 463 
switches, as well as internet access, to interconnect the solution components. The lab network is not 464 
connected to the NIST enterprise network. Table 5-1 lists (alphabetically) the software and hardware 465 
components we used, as well as the specific function each component. 466 

Table 5-1 Example Implementation Component List 467 

Product Vendor Component Name Function 
GreenTec WORMdisk Secure, immutable hardware 

Hewlett Packard Enterprise 
(HPE) 

ArcSight ESM Log analysis, correlation, 
management, and reporting  

IBM Spectrum Protect File-level, disk-level, and system-
level backup and recovery 

Tripwire Enterprise and Log Center File integrity monitoring and 
database metadata integrity 
monitoring 

Veeam Availability Suite VM backup and restore 
The architecture depicted in Figure 5-1 describes a solution built around several typical infrastructure 468 
components: a Microsoft Exchange server, a Microsoft SharePoint server, a Microsoft Structured Query 469 
Language (MS SQL) server, a Microsoft Hyper-V server, and a Microsoft Active Directory server that also 470 
runs Microsoft Domain Name System service, as well as an array of client machines, primarily running 471 
Windows 10 and Ubuntu 16.04.  472 

The solution consists of several products to comprise an enterprise DI solution. 473 

Organizations should have backup capability that can be used to back up files, disks, and systems. Tools 474 
that provide backup capability may also provide capabilities to back up databases or email servers. 475 
These tools should include management capabilities for backups that provide configuration options such 476 
as when and how data should be backed up. IBM Spectrum Protect provides backup capability in this 477 
build. Clients are installed on all machines that need backup and restore capabilities. Furthermore, IBM 478 
Spectrum Protect uses incremental backups; essentially, this means that it stores an initial full backup of 479 
a user’s system. After this initial backup, additional backups are performed only after changes occur in 480 
data.  481 

Secure storage is important for protecting backups and other forms of data in an enterprise DI solution. 482 
Secure storage involves write-protected or write-controlled devices, which prevent data from being 483 
modified or deleted. By integrating backup infrastructure with these disks, it is possible to permanently 484 
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preserve backups and protect them from harmful malware and accidental deletion. GreenTec 485 
WORMdisks are a secure storage solution that protects data on a firmware level. WORMdisks come with 486 
software to lock disks or portions of disks permanently or temporarily. Once WORMdisks are locked, 487 
they are immutable and any data on the disk is read-only. Implementation instructions are included for 488 
backing up directly to GreenTec WORMdisks using IBM Spectrum Protect, as well as instructions for 489 
copying backup data from IBM Spectrum Protect to a WORMdisk. Other files stored on these disks can 490 
be copied over using the operating system’s usual methods. WORMdisks are transparent to the 491 
operating system in terms of use, so they function as regular storage drives until they are locked. 492 

Corruption testing involves periodic or manual testing of files for modifications, deletions, additions, or 493 
other potential DI events. Tools that provide corruption testing may also test other systems, such as 494 
databases or mail servers. Tripwire Enterprise provides corruption testing for this build. By using 495 
individual agents installed on client machines, Tripwire Enterprise generates file integrity information for 496 
a set of specified files and folders. Tripwire Enterprise can also generate file integrity information for 497 
database metadata, allowing administrators to track changes made to database structure. It stores this 498 
metadata in a database. For simplicity, we use the MS SQL server to store the file integrity information, 499 
but this could be done in a separate database for processing efficiency. Tripwire Enterprise forwards 500 
logs that it generates to Tripwire Log Center. Tripwire Log Center allows for filtering and processing of 501 
Tripwire Enterprise logs as well as the ability to integrate with other log collection tools.  502 

Many organizations have virtual infrastructure that allows them to manage the distribution of VMs 503 
across their enterprise. When implementing a DI solution, the virtual infrastructure should include the 504 
ability to granularly backup and restore VMs. Veeam Backup and Replication is a tool that can integrate 505 
with Hyper-V and VMware to jointly comprise the virtual infrastructure of our build. Veeam Backup and 506 
Replication can provide granular backup and restore capabilities. It can perform restores of entire VMs 507 
as well as restores on individual files in virtualized environments. Veeam Backup and Replication is 508 
server based and can be applied to Hyper-V machines that run on various systems across the enterprise.  509 

Logging is another important piece of a DI solution. The collection of logs from various sources is useful 510 
in identifying the root cause of DI events, whether they are caused by accident or by malicious insiders 511 
or software. Furthermore, logs aid in identifying the time of the last known good and inform decisions 512 
regarding restoration. In this build, HPE ArcSight ESM is used to collect logs from various sources. 513 
Included in the architecture is an HPE ArcSight Connector server. Through Active Directory, the 514 
connector server acquires system and security logs from all Windows endpoints in the domain. These 515 
logs are then forwarded to HPE ArcSight ESM. Implementation instructions are included for other, non-516 
default sources. HPE ArcSight ESM can log MS SQL queries and collect Hyper-V application logs, Veeam 517 
application logs, and Ubuntu syslogs, and provides instructions for each. In the case of Hyper-V 518 
application logs and Veeam application logs, we provide sample custom parsers for forwarding some 519 
events to HPE ArcSight ESM (see Volume 3). Additionally, ESM integrates with Tripwire Log Center to 520 
provide log collection for all file integrity monitoring logs generated by Tripwire Enterprise. HPE ArcSight 521 
ESM can sort, filter, and audit logs from all its sources. The information gathered from these logs should 522 
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provide system administrators the context they need to determine how to fully remediate systems 523 
affected by destructive malware. 524 

Figure 5-1 Example Implementation Architecture 525 

 526 

5.1 Use Cases 527 

5.1.1  Ransomware 528 

5.1.1.1  Scenario 529 

A malicious piece of software run by the user encrypts the entire documents folder. This renders files 530 
unusable and pictures unable to be viewed, and users will only be able to see encrypted text should they 531 
attempt to open any of the files in a text editor. Though the software’s scope is limited to the 532 
documents folder, the approach could be more widely applied to encrypt other folders and even system 533 
files, resulting in an attack on the availability of systems and data alike. 534 

5.1.1.2 Resolution 535 

This use case is resolved using a combination of several tools. The corruption testing component 536 
(Tripwire Enterprise) is used to detect changes in the file systems of various selected machines, 537 
specifically when files are modified or overwritten. The corruption testing component provides context 538 
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for these events, such as a time stamp, the user responsible, the affected files, and the program that 539 
modified the file (if applicable).  540 

The logging component (HPE ArcSight ESM) collects logs from various sources for analysis and reporting. 541 
Logs are forwarded from the corruption testing component for analysis by a system administrator. The 542 
logging component provides search, filtering, and correlation capabilities for auditing, allowing 543 
enterprises to manage the quantity of logs generated by the corruption testing component and other 544 
sources.  545 

These two components work together to provide information about the files encrypted by the 546 
ransomware tool: the name of the program that encrypted the files, which files were affected, when 547 
they were affected, and which user ran the program. This information aids in removing the ransomware 548 
from the system and contributes to the identification of the last known good. However, it does not 549 
actually restore the availability of the user’s files. The backup capability component (IBM Spectrum 550 
Protect) is used to restore encrypted files.  551 

5.1.1.3 Other Considerations 552 

In the event of a system failure caused by ransomware, it is important to note that recovery requires the 553 
installation of the IBM Spectrum Protect client (if IBM Spectrum Protect is used as the backup 554 
capability). If a system failed due to ransomware and cannot be rebooted, this client may not be 555 
immediately accessible. Restoration would require the reinstallation of the operating system and then 556 
installation of the IBM Spectrum Protect client. The client could then restore all files, including system 557 
files, to their previous state. Products exist that work with IBM Spectrum Protect to automate and 558 
accelerate this process. 559 

Also, there is a trade-off between the frequency of backups and the amount of data loss an enterprise 560 
will experience. More frequent backups require more resources, both in work performed by the client 561 
and space required on the server. More frequent backups, however, provide more granularity in 562 
recovery capabilities. This can be managed by backing up active files more frequently and dormant files 563 
less frequently. An active file will lose more data during recovery because the restoration is to a point in 564 
time and will not reflect recent changes to the file.  565 

Another caveat of more frequent (i.e., automated) backups is that if a backup is taken after a 566 
ransomware attack, the backup infrastructure will retain backups of the encrypted data. Though this is 567 
undesirable, it is still possible to restore to previous versions. This scenario highlights the importance of 568 
file monitoring capabilities, which can guide users to restoring to the correct backup.  569 
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5.1.2  File Modification and Deletion 570 

5.1.2.1 Scenario 571 

A malicious piece of software is downloaded from a phishing website and run by the user. The software 572 
recursively modifies files in the directory in which it is running. It removes and replaces pieces of text 573 
files, such as numbers and common English words, sometimes removing entire lines of text. It also 574 
deletes any file it doesn’t recognize as text, such as pictures, videos, and music files. This results in 575 
potentially detrimental data loss. Furthermore, since files are deleted and not just encrypted, recovery is 576 
impossible without a backup infrastructure in place. There is no option to decrypt files that were deleted 577 
from the system, so compensating the creators of the malicious software for data recovery is not an 578 
option. 579 

5.1.2.2 Resolution 580 

Though this use case is more destructive than ransomware, the same tools are used to recover from it. 581 
The corruption testing component (Tripwire Enterprise) is used to test sensitive files and folders, and 582 
reports information such as the time, user, and the name of the malicious software that deleted and 583 
modified the now corrupted files. Even though files are missing and not just encrypted, their deletion 584 
will still be reported.  585 

The logs generated by the corruption testing component are forwarded to the logging component (HPE 586 
ArcSight ESM) for collection and processing by a system administrator. The administrator can use the 587 
information to determine how to respond to the event—how to remove the malicious software, how to 588 
prevent it from spreading, and which files to restore. The combination of logging in concert with 589 
corruption testing provides the ability to identify the last known good.  590 

The backup capability (IBM Spectrum Protect) is used to restore modified, corrupted, and deleted files. 591 
Even though files are missing from the user’s system, they are still present in the backup capability 592 
component, and the user need only choose which backup version to restore to.  593 

5.1.2.3 Other Considerations 594 

Please see Section 5.1.1.3 for a discussion of tradeoffs between the frequency of backups, resources 595 
required, and restoration granularity, as they are applicable to this use case.  596 

Again, if a backup is taken after malicious software runs but before recovery, the corrupted data will be 597 
retained by the backup infrastructure. However, it will still be possible to restore to an older version of 598 
the data with IBM Spectrum Protect (if IBM Spectrum Protect is used). IBM Spectrum Protect will not 599 
back up deleted files, however, so in the event of file deletion, the last backup taken should be sufficient 600 
for recovery, unless the user has a specific reason to recover from an earlier version. 601 
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5.1.3 VM Deletion 602 

5.1.3.1 Scenario 603 

A user accidentally deleted a VM in Hyper-V. In this use case, it is assumed that the user has access to 604 
the VM. Although the deletion may not set off any red flags by detection systems since a privileged user 605 
deleted the machine, it is still undesired. Since VMs can be used for several purposes—such as access to 606 
software unavailable on the host operating system (OS), emulation of infrastructure before deployment, 607 
or simply storing files for use in the user’s preferred OS—the deletion of a VM can cause significant data 608 
loss and disruption in work flow.  609 

5.1.3.2 Resolution 610 

The VM deletion is resolved using a combination of the logging component (HPE ArcSight ESM) and the 611 
virtual infrastructure (Veeam Backup and Restore, Hyper-V). This use case deals specifically with an 612 
accidental deletion by a benign user. Because of this, logs pertaining to the deletion are likely 613 
unnecessary for recovery. However, other use cases may require logs, especially in the event of a 614 
malicious VM deletion. Therefore, our resolution includes a method for integrating the selected virtual 615 
infrastructure tools and logging component. The integration allows for the collection of logs regarding 616 
the deletion of the VM as well as logs pertaining to the restoration of the VM once complete. The virtual 617 
infrastructure is used to restore the entire deleted VM.  618 

5.1.3.3 Other Considerations 619 

The chosen virtual infrastructure components (Veeam Backup and Restore, Hyper-V) allow for more 620 
granular recovery–files on the guest OS can be recovered, not just the entire VM. This extends the user’s 621 
restoration capabilities in events where data corruption happens within the VM. However, it is unlikely 622 
that file change logs will be forwarded to the logging component (HPE ArcSight ESM), meaning that such 623 
recovery capabilities do not meet all the requirements of this reference design.  624 

5.1.4 Active Directory Permission Change 625 

5.1.4.1 Scenario 626 

A malicious insider creates backdoors into a Microsoft Exchange server. Since the culprit is an insider, he 627 
or she is assumed to be privileged. The backdoor accounts have administrator privileges and can make 628 
changes to various settings in the Exchange infrastructure. This results in potential data leaks, which 629 
could involve forwarding emails from all users to an off-site account.  630 

5.1.4.2 Resolution 631 

This use case is resolved primarily using the logging component (HPE ArcSight ESM) and the built-in 632 
Microsoft Windows server recovery capabilities. Since system and security logs are reported to the 633 
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logging component, administrators will be able to find which user created the accounts, the names of all 634 
the accounts created, when they were created, and the account activities. The administrator could 635 
choose to delete the accounts manually, but Windows includes a method for restoring the system state. 636 
Since restoring the system state is more complicated in later Windows server versions, the chosen 637 
backup capability (IBM Spectrum Protect) is not used for the restoration. As stated in the product 638 
documentation, the preferred method for recovering the system state is through the Microsoft 639 
Windows System State restoration process.  640 

This restore is performed on the Active Directory server (as opposed to the Microsoft Exchange server) 641 
since the accounts, though created from the Exchange server, are stored on the Active Directory server.  642 

5.1.4.3 Other Considerations 643 

IBM Spectrum Protect recommends using the Microsoft Windows System State backup and recovery 644 
tool for later Windows versions. 645 

5.1.5 Database Transactions 646 

5.1.5.1 Scenario 647 

A malicious or careless insider changes database data that is necessary for enterprise operations. The 648 
user is assumed to be privileged. Through the course of interacting with the database, the user executes 649 
a query that inserts, deletes, or modifies data in a way that harms enterprise operations.  650 

5.1.5.2 Resolution 651 

The event is detected with the logging capability (HPE ArcSight ESM). Database integrity is restored 652 
through a system of transactional rollbacks. Since the logging capability includes database query log 653 
collection, administrators will be able to find which users modified the database, and what queries were 654 
run. Given this information, administrators can determine the harmful queries and when the database 655 
was in its desired state. Transactional rollbacks are then used to restore the database to the last known 656 
good state.  657 

5.1.5.3 Other Considerations 658 

Restoration need not be conducted on the database server, depending on the method of rollbacks 659 
employed. The database modification can be conducted on any machine.  660 

Transactional rollbacks require that queries be explicitly executed within “transactions.” During the 661 
restoration process, a transactional ID is specified to restore to. An enterprise can choose to force 662 
queries to use transactions through the implementation of a proxy between all potential endpoints and 663 
the database. Through this precise processing of queries, granular restoration can be achieved, though 664 
potentially at cost to efficiency.  665 
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5.1.6 Database Metadata Modification 666 

5.1.6.1 Scenario 667 

A malicious or careless insider changes the metadata of the system’s main database. The user is 668 
assumed to be privileged. Through the course of interacting with the database, the user executes a 669 
query that changes the name of a key table. This results in a loss of functionality of the database for any 670 
queries that wish to use that table.  671 

5.1.6.2 Resolution 672 

This use case is resolved through database restoration capabilities—in this case, inherent to the 673 
database. Both the corruption testing component (Tripwire Enterprise) and the logging component (HPE 674 
ArcSight ESM) are used to detect the event. Through these components, administrators will be able to 675 
find which users modified the database. It is possible to manually revert the changes, but the built-in 676 
database backup and restoration capabilities can also be used to fix the metadata.  677 

Regardless of where the database modification query was run, recovery occurs on the database server 678 
to the last known good.  679 

5.1.6.3 Other Considerations 680 

Backup scheduling tied to the database is separate from the backup capability (IBM Spectrum Protect). If 681 
tools are used that require separate database backup procedures, security policies and backup 682 
schedules should be designed to accommodate this fact.  683 

Note: The use of backups to restore databases that have had adverse changes to their metadata may 684 
result in the loss of all data since the backup was taken. Reversing the changes manually is more time-685 
consuming but more precise.  686 

6 Security Characteristics Analysis 687 

This evaluation focuses on the security of the reference design itself. In addition, it seeks to understand 688 
the security benefits and drawbacks of the example solution. 689 

6.1 Assumptions and Limitations 690 

The security characteristic evaluation has several limitations: 691 

 It is not a comprehensive test of all security components, nor is it a red team exercise. 692 

 It cannot identify all weaknesses. 693 
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 It does not include the lab infrastructure. It is assumed that devices are hardened. Testing these 694 
devices would reveal only weaknesses in implementation that would not be relevant to those 695 
adopting this reference architecture. 696 

6.2 Analysis of the Reference Design’s Support for CSF Subcategories 697 

Table 3-2 lists the reference design functions and the security characteristics, along with products that 698 
we used to instantiate each capability. The focus of the security evaluation is not on these specific 699 
products but on the CSF subcategories, because, in theory, any number of commercially available 700 
products could be substituted to provide the CSF support represented by a given reference design 701 
capability. 702 

This section discusses how the reference design supports each of the CSF subcategories listed in Table 3-703 
1. Using the CSF subcategories as a basis for organizing our analysis allowed us to systematically 704 
consider how well the reference design supports specific security activities and provides structure to our 705 
security analysis. 706 

6.2.1 PR.IP-3: Configuration Change Control Processes Are in Place  707 
The reference design protects the configuration from change and detects changes in the configuration 708 
using secure hardware and file integrity monitoring. It does not include processes for change control, 709 
however, which the adopting organization should implement. 710 

6.2.2 PR. IP-4: Backups of Information Are Conducted, Maintained, and Tested 711 

Periodically  712 
The reference design includes capabilities for creating backups of information from various sources:  713 

 file systems 714 

 disks 715 

 virtualized environments 716 

 databases 717 

It also describes scheduling capabilities for each of these backup targets, allowing for periodic backups 718 
as well as manual backups. The design provides the capability to test and maintain backups, but 719 
planning schedules, maintenance, and testing of backups are left to the adopting organization. 720 

By adopting this reference design, organizations gain the capability to conduct, maintain, and test 721 
backups, and in doing so, the organizations will support the technical requirements of CSF subcategory 722 
PR.IP-4.  723 
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6.2.3 PR.DS-1: Data-at-Rest Is Protected  724 
The reference design supports the protection of data-at-rest through: 725 

 secure hardware as protection against data corruption 726 

 encryption of backups as protection against unauthorized access 727 

Through these combined capabilities, the reference design can protect data-at-rest from both 728 
unauthorized reads and writes. This protection only applies to data that is stored using the capability of 729 
the reference design. Utilization of the reference design is necessary for data protection; 730 
implementation alone is not sufficient. 731 

By adopting this reference design, organizations gain the capability to protect data-at-rest, and in doing 732 
so, the organizations will support the technical requirements of CSF subcategory PR.DS-1. 733 

6.2.4 PR.DS-6: Integrity Checking Mechanisms Are Used to Verify Software, 734 

Firmware, and Information Integrity  735 
The reference design supports integrity checking for various types of data, including:  736 

 files stored in file systems 737 

 database metadata 738 

 logs 739 

 software 740 

Firmware that is stored on special hardware may be out of the scope of the design. It should be possible 741 
to monitor firmware stored as files; however, this reference design does not include firmware or 742 
software integrity verification against online resources.  743 

By adopting this reference design, organizations gain the capability to monitor file integrity within their 744 
system. This partially supports the technical requirements of CSF subcategory PR.DS-6, but the 745 
verification of integrity for firmware and software against verified sources is out of scope.  746 

6.2.5 PR.PT-1: Audit/Log Records Are Determined, Documented, Implemented, and 747 

Reviewed in Accordance with Policy  748 
The reference design supports auditing, log collection, log analysis, and log correlation. It includes 749 
mechanisms for collecting logs from: 750 

 Microsoft event logs 751 

 Windows application logs 752 

 Linux system logs 753 
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 file integrity logs 754 

 custom log sources 755 

 database query history 756 

Logs are aggregated into a single interface, which allows for searching, correlating, and analyzing logs 757 
from across an enterprise. Reviewing these logs is left to the individual organization. 758 

By adopting this reference design, organizations gain the technical capability to aggregate, correlate, 759 
and analyze logs as well as perform audits across an enterprise. In doing so, the organizations will 760 
support the technical requirements of CSF subcategory PR.PT-1. 761 

6.2.6 DE.CM-3: Personnel Activity Is Monitored to Detect Potential Cybersecurity 762 

Events  763 
The reference design supports log collection for various activities across an enterprise, including: 764 

 file creation, deletion, modification, and renaming 765 

 account creation, deletion, and modification 766 

 database queries and other activity 767 

These collected logs, where possible, have users and programs associated with them. The design does 768 
not support active monitoring of user activity or monitoring of network activity. However, logs are 769 
provided for relevant activities, so that informed decisions can be made when an organization decides 770 
how to recover from destructive malware. 771 

By adopting this reference design, organizations will gain the technical capability to review some 772 
personnel activity after a cybersecurity event has occurred, and in doing so, partially support the 773 
technical requirements of CSF subcategory DE.CM-3. 774 

6.2.7 DE.CM-1: The Network Is Monitored to Detect Potential Cybersecurity Events 775 
The reference design supports the monitoring of some network activity in the enterprise. Network 776 
information is correlated with all logged cybersecurity events to determine: 777 

 Source Internet Protocol (IP) of event (if applicable) 778 

 Destination IP of event (if applicable) 779 

 Port (if applicable) 780 

Though these collected logs have network information associated with them, network activity is not 781 
directly monitored for anomalies. Since the focus of this project is recovery, the reference design 782 
supports enough network information to recover from a cybersecurity event, but will not attempt to 783 
detect cybersecurity events based on network traffic or packet analysis.  784 
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By adopting this reference design, organizations will gain the technical capability to associate DI events 785 
with network information, and in doing so, will partially support the technical requirements of CSF 786 
subcategory DE.CM-1.  787 

6.2.8 DE.CM-2: The Physical Environment Is Monitored to Detect Potential 788 

Cybersecurity Events  789 
The reference design supports the monitoring of physical machines in the enterprise through the real-790 
time monitoring of: 791 

 file integrity 792 

 database metadata integrity 793 

 database queries 794 

This reference design does not include monitoring for physical cybersecurity events, such as the 795 
insertion of potentially malicious flash drives.  796 

By adopting this reference design, organizations will only partially gain the technical capability required 797 
to fully monitor the physical environment, and in doing so, partially support the technical requirements 798 
of CSF subcategory DE.CM-2.  799 

6.2.9  PR.IP-9: Response Plans and Recovery Plans Are in Place and Managed 800 
The reference design supports notification after a DI event as well as the infrastructure required for 801 
recovery, including:  802 

 logs for analysis and auditing events after they happen 803 

 backup and restore capabilities for successful recovery 804 

The design supports the technical requirements of a recovery plan; however, the details of the plan 805 
should be put in place by the adopting organizations. 806 

By adopting this reference design, organizations will gain the technical capability required to recover 807 
from a DI event, and in doing so, support the technical requirements of CSF subcategory PR.IP-9. 808 

6.2.10  DE.AE-4: Impact of Events Is Determined 809 
The reference design supports an infrastructure to determine the scope of DI events as well as create 810 
plans of action for remediation. This infrastructure includes: 811 

 logs that identify impacted files and systems 812 

 auditing to determine responsible parties after an event occurs 813 
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The design provides the forensic ability to determine affected systems and responsible parties but does 814 
not act on this information without human intervention. Adopting organizations should create plans to 815 
use this information for remediation.  816 

By adopting the design, organizations will only partially gain the technical capability required to 817 
determine the impact of events, and in doing so, partially support the technical requirements of CSF 818 
subcategory DE.AE-4. 819 

6.3 Security of the Reference Design 820 

The list of reference design capabilities in Table 3-2 focuses on the capabilities needed to ensure the 821 
integrity of system data. Table 3-2 does not focus on capabilities that are needed to manage and secure 822 
the reference design. However, the reference design itself must be managed and secured. To this end, 823 
this security evaluation focuses on the security of the reference design itself. 824 

Measures implemented to protect the reference design from outside attack include:  825 

 isolating certain capabilities on separate subnetworks protected by firewalls 826 

 Implementing a management network to isolate log and management traffic from the 827 
production (business operations) networks 828 

 securing critical user access information and logs to protect them from unauthorized insertion, 829 
modification, or deletion 830 

 logging all privileged user access activities 831 

 using encryption and integrity protection of user access information and logs while this 832 
information is in transit between capabilities  833 

Table 6-1, Capabilities for Managing and Securing the DI Reference Design, describes the security 834 
protections each capability provides and lists the corresponding products that were used to instantiate 835 
each capability. The security evaluation focuses on the capabilities rather than the products. The NCCoE 836 
is not assessing or certifying the security of the products included in the example implementation. We 837 
assume that the enterprise already deploys network security capabilities such as firewalls and intrusion 838 
detection devices that are configured per best practices. The focus here is on securing capabilities 839 
introduced by the reference design and minimizing their exposure to threats. 840 

6.3.1 Deployment Recommendations 841 
When deploying the reference design in an operational environment, organizations should follow 842 
security best practices to address potential vulnerabilities and ensure that all solution assumptions are 843 
valid to minimize any risk to the production network. Organizations leveraging the reference design 844 
should adhere to the following list of recommended best practices that are designed to reduce risk. 845 
Note that the laboratory instantiation of the reference design did not implement every security 846 
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recommendation. Organizations should not, however, consider this list to be comprehensive; merely 847 
following this list will not guarantee a secure environment. Organizations must also take into 848 
consideration items such as user access controls, continuity of operations planning, and environmental 849 
elements that are not addressed in this document. Planning for design deployment gives an organization 850 
the opportunity to go back and audit the information in its system and get a more global, correlated, 851 
and disambiguated view of the DI controls that are in effect. 852 

6.3.1.1 Patch, Harden, Scan, and Test [6] 853 

 Keep OSs up-to-date by patching, version control, and monitoring indicators of compromise 854 
(e.g., performing virus and malware detection as well as keeping anti-virus signatures up-to-855 
date).  856 

 Harden all capabilities by deploying on securely configured OSs that use long and complex 857 
passwords and are configured per best practices.  858 

 Scan OSs for vulnerabilities. 859 

 Test individual capabilities to ensure that they provide the expected CSF subcategory support 860 
and that they do not introduce unintended vulnerabilities.  861 

 Evaluate reference design implementations before going operational with them. 862 

6.3.1.2 Other Security Best Practices [7] 863 

 Install, configure, and use each capability of the reference design per the security guidance 864 
provided by the capability vendor.  865 

 Change the default password when installing software. 866 

 Identify and understand which predefined administrative and other accounts each capability 867 
comes with by default to eliminate any inadvertent backdoors into these capabilities. Disable all 868 
unnecessary predefined accounts and, even though they are disabled, change the default 869 
passwords in case a future patch enables these accounts. 870 

 Segregate reference design capabilities on their own subnetwork, separate from the production 871 
network, either physically or using virtual private networks and port-based authentication or 872 
similar mechanisms. 873 

 Protect the various reference design subnetworks from each other and from the production 874 
network using security capabilities such as firewalls and intrusion detection devices that are 875 
configured per best practices.  876 

 Configure firewalls to limit connections between the reference design network and the 877 
production network, except for connections needed to support required inter-network 878 
communications to specific IP address and port combinations in certain directions.  879 
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 Configure and verify firewall configurations to ensure that data transmission to and from 880 
reference design capabilities is limited to interactions that are needed. Restrict all permitted 881 
communications to specific protocols and IP address and port combinations in specific 882 
directions. 883 

 Monitor the firewalls that separate the various reference design subnetworks from one another. 884 

 NIST SP 1800-9C: How-To Guides contains the firewall configurations that show the rules 885 
implemented in each of the firewalls for the example implementation. These configurations are 886 
provided to enable the reader to reproduce the traffic filtering/blocking that was achieved in 887 
the implementation. 888 

 Apply encryption or integrity-checking mechanisms to all information exchanged between 889 
reference design capabilities (i.e., to all user access, policy, and log information exchanged) so 890 
that tampering can be detected. Use only encryption and integrity mechanisms that conform to 891 
most recent industry best practices. Note that in the case of directory reads and writes, 892 
protected mode is defined as the use of Lightweight Directory Access Protocols (Request for 893 
Comments 2830). 894 

 Strictly control physical access to both the reference design and the production network.  895 

 Deploy a configuration management system to serve as a “monitor of monitors” to ensure that 896 
any changes made to the list of information are logged and reported to the monitoring system 897 
or to the analytics in the monitoring system and notifications are generated. Such a system 898 
could also monitor whether reference design monitoring capabilities, such as log integrity 899 
capabilities or the monitoring system itself, go offline or stop functioning, and generate alerts 900 
when these capabilities become unresponsive. 901 

 Deploy a system that audits and analyzes directory content to create a description of who has 902 
access to what resources and validate that these access permissions correctly implement the 903 
enterprise’s intended business process and access policies. 904 

6.3.1.3 Policy Recommendations 905 

 Define the access policies to enforce the principles of least privilege and separation of duties.  906 

 Equip the monitoring capability with a complete a set of rules to take full advantage of the 907 
ability to identify anomalous situations that can signal a cyber event. Define enterprise-level 908 
work flows that include business and security rules to determine each user’s access control 909 
authorizations and ensure that enterprise access control policy is enforced as completely and 910 
accurately as possible.  911 

 Develop an attack model to help determine the type of events that should generate alerts. 912 

 Grant only a very few users (e.g., human resource administrators) the authority to modify 913 
(initiate, change, or delete) employee access information. Require the approval of more than 914 



DRAFT 

NIST SP 1800-11B: Data Integrity 32 

one individual to update employee access information. Log all employee access information 915 
modifications. Define work flows to enforce these requirements. 916 

 Grant only a very few users (e.g., access rules administrators) the authority to modify (initiate, 917 
change, or delete) access rules. Require the approval of more than one individual to update 918 
access rules. Log all access rule modifications. Define work flows to enforce these requirements. 919 

 Grant only a very few users (e.g., security analyst) the authority to modify (initiate, change, or 920 
delete) the analytics that are applied to log information by the monitoring capability to 921 
determine what constitutes an anomaly and generates an alert. Any changes made to the 922 
analytics should, by policy, require the approval of more than one individual, and these changes 923 
should themselves be logged, with the logs sent to a monitor-of-monitors system other than the 924 
monitoring system and to all security analysts and other designated individuals. Define work 925 
flows to enforce these requirements. 926 
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Table 6-1 Capabilities for Managing and Securing the DI Reference Design  927 

This table describes only the product capabilities and CSF subcategory support used in the reference architecture. Many of the products have 928 
significant additional security capabilities that are not listed here. 929 

Capability Specific Product Function CSF Subcategories 
Subnetting N/A Technique of segmenting the network on 

which the reference design is deployed so 
that capabilities on one subnetwork are 
isolated from capabilities on other 
subnetworks. If an intruder gains access to 
one segment of the network, this technique 
limits the intruder’s ability to monitor traffic 
on other segments of the network. For 
example, the enterprise’s production 
network, on which user access information 
and decisions are conveyed, is separate from 
the reference design’s monitoring and 
management subnetwork. 

PR.DS-1: Data-at-rest is protected. 
PR.PT-4: Communications and control 
networks are protected. 

Privileged 
Access 
Management 

Active Directory Manages privileged access to the OSs of all 
physical reference design capabilities. This is 
the single portal into which all users with 
administrator privileges must log in; it defines 
what systems these administrators are 
authorized to access based on their role and 
attributes. It also logs every login that is 
performed by users with administrator 
privileges, creating an audit trail of privileged 

PR.AC-3: Remote access is managed. 
PR.AC-4: Access permissions are 
managed, incorporating the principles 
of least privilege and separation of 
duties. 
PR.PT-3: Access to systems and assets 
is controlled, incorporating the 
principle of least functionality. 
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Capability Specific Product Function CSF Subcategories 
user access to the OSs of the physical systems 
that are hosting reference design capabilities. 

DE.CM-3: Personnel activity is 
monitored to detect potential 
cybersecurity events. 

Virtual 
Environment 
Privileged 
Access 
Management 

Hyper-V 
VEEAM 
Active Directory 

Manages privileged access to the virtual 
environment (including machines, switches, 
and host hardware) that host reference 
design capabilities. Hyper-V defines what 
VMs users are authorized to access based on 
the user’s role. It logs activity that 
administrators perform on VMs, but it does 
not log operations that are performed on the 
OSs that are installed on those VMs. These 
logs create an audit trail of privileged user 
access to the virtual environment that is 
hosting the reference design capabilities. 

PR.AC-3: Remote access is managed. 
PR.AC-4: Access permissions are 
managed, incorporating the principles 
of least privilege and separation of 
duties. 
PR.PT-3: Access to systems and assets 
is controlled, incorporating the 
principle of least functionality. 
DE.CM-3: Personnel activity is 
monitored to detect potential 
cybersecurity events. 

Log Integrity Tripwire Enterprise 
HPE ArcSight ESM 

Forwards log information from each 
reference design capability to the monitoring 
capability.  
 
If an alternative product were used to 
instantiate this capability, it could add a time 
stamp and hash/integrity seal to each log file, 
thereby providing the file with integrity, but 
not confidentiality, protections. However, if 
the hash/integrity seal were to continue to 
be stored with the log file at the monitoring 
capability, it would provide a mechanism to 

PR.DS-6: Integrity checking 
mechanisms are used to verify 
software, firmware, and information 
integrity. 
PR.PT-1: Audit/log records are 
determined, documented, 
implemented, and reviewed in 
accordance with policy. 
DE.AE-3: Event data is aggregated and 
correlated from multiple sources and 
sensors. 
PR.DS-2: Data-in-transit is protected. 
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Capability Specific Product Function CSF Subcategories 
detect unauthorized modifications made to 
the log file while stored there. 
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7 Functional Evaluation 930 

A functional evaluation of the DI example implementation, as constructed in our laboratory, was 931 
conducted to verify that it meets its objective of demonstrating the ability to recover from DI attack. The 932 
evaluation verified that the example implementation could perform the following functions: 933 

 recover from an identified ransomware attack 934 

 recover from a data destruction event  935 

 recover from a data manipulation event  936 

Section 7.1 describes the format and components of the functional test cases. Each functional test case 937 
is designed to assess the capability of the example implementation to perform the functions listed 938 
above and detailed in Section 7.1.1.  939 

7.1 Data Integrity Functional Test Plan 940 

One aspect of our security evaluation involved assessing how well the reference design addresses the 941 
security characteristics it was intended to support. The CSF subcategories were used to provide 942 
structure to the security assessment by consulting the specific sections of each standard that are cited in 943 
reference to that subcategory. The cited sections provide validation points that the example solution is 944 
expected to exhibit. Using the CSF subcategories as a basis for organizing our analysis allowed us to 945 
systematically consider how well the reference design supports the intended security characteristics. 946 

This plan includes the test cases necessary to conduct the functional evaluation of the DI example 947 
implementation, which is currently deployed in a lab at the NCCoE. The implementation tested is 948 
described in Section 5. 949 

Each test case consists of multiple fields that collectively identify the goal of the test, the specifics 950 
required to implement the test, and how to assess the results of the test. Table 7-1 describes each field 951 
in the test case. 952 

Table 7-1 Test Case Fields 953 

Test Case Field Description 
Parent requirement Identifies the top-level requirement or the series of top-level 

requirements leading to the testable requirement. 

Testable requirement Drives the definition of the remainder of the test case fields. Specifies the 
capability to be evaluated. 

Associated security 
controls 

Lists the NIST SP 800-53 rev 4 controls addressed by the test case. 
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Test Case Field Description 
Description Describes the objective of the test case. 

Associated test cases In some instances, a test case may be based on the outcome of another 
test case(s). For example, analysis-based test cases produce a result that is 
verifiable through various means (e.g., log entries, reports, and alerts).  

Preconditions The starting state of the test case. Preconditions indicate various starting 
state items, such as a specific capability configuration required or specific 
protocol and content. 

Procedure The step-by-step actions required to implement the test case. A procedure 
may consist of a single sequence of steps or multiple sequences of steps 
(with delineation) to indicate variations in the test procedure. 

Expected results The expected results for each variation in the test procedure. 

Actual results The observed results. 

Overall result The overall result of the test as pass/fail. In some test case instances, the 
determination of the overall result may be more involved, such as 
determining pass/fail based on a percentage of errors identified. 

7.1.1 Data Integrity Use Case Requirements  954 

Table 7-2 identifies the DI functional evaluation requirements that are addressed in the test plan and 955 
associated test cases. 956 
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Table 7-2 Data Integrity Functional Requirements 957 

Capability Re-
quirement (CR) 
ID 

Parent Requirement Sub-requirement 1 Test Case 

CR 1 The DI example 
implementation shall 
respond/recover from 
malware that encrypts 
files and displays notice 
demanding payment. 

  

CR 1.a  Produce notification 
of security event  

Data Integrity -1 

CR 1.b  Provide file integrity 
monitor 

Data Integrity -1 

CR 1.c  Revert to last known 
good  

Data Integrity -1 

CR 2 The DI example 
implementation shall 
recover when malware 
destroys data on user’s 
machine. 

  

CR 2.a  Provide file integrity 
monitor 

Data Integrity -2 

CR 2.b  Revert to last known 
good 

Data Integrity -2 

CR 3 The DI example 
implementation shall 
recover when a user 
modifies a configuration 
file in violation of 
established baselines. 

  

CR 3.a  Provide file integrity 
monitor 

Data Integrity -3 
Data Integrity -6 

CR 3.b  Revert to last known 
good 

Data Integrity -3 
Data Integrity -6 

CR 3.c  Provide user activity 
auditing 

Data Integrity -6 
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Capability Re-
quirement (CR) 
ID 

Parent Requirement Sub-requirement 1 Test Case 

CR 4 The DI example 
implementation shall 
recover when an 
administrator modifies a 
user’s file.  

  

CR 4.a  Provide file integrity 
monitor  

Data Integrity -4 

CR-4.b  Provide user activity 
auditing  

Data Integrity -4 

CR 4.c  Revert to last known 
good 

Data Integrity -4 

CR-5 The DI example 
implementation shall 
recover when an 
administrator and/or 
script modifies data in a 
database. 

  

CR 5.a  Use database 
transaction auditing 

Data Integrity -5 

CR 5.b  Roll back to last 
known good  

Data Integrity -5 

CR-6 The DI example 
implementation shall 
recover when a user 
modifies a configuration 
file in violation of 
established baselines. 

  

CR 6.a  Provide file integrity 
monitor  

Data Integrity -6 

CR 6.b  Revert to last known 
good 

Data Integrity -6 

CR 6.c  Provide user activity 
auditing 

Data Integrity -6 

958 
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7.1.2 Test Case: Data Integrity -1 959 
Table 7-3 Test Case ID: Data Integrity -1 960 

Parent requirement (CR 1) The DI example implementation shall respond/recover from 
malware that encrypts files and displays notice demanding 
payment. 

Testable requirement (CR 1.a) Logging, (CR 1.b) Corruption Testing, (CR 1.c) Backup 
Capability 

Description Show that the DI solution can recover from a DI attack that was 
initiated via ransomware. 

Associated test cases N/A 

Associated CSF Subcategories DE.DP-4, RS.CO-2, DE.EA-5, PR.DS-1, PR.DS-6, PR.PT-1 

Preconditions User downloaded and ran an executable from the internet that is 
ransomware. The user’s files are then encrypted by the 
ransomware. 

Procedure 1. Open the Tripwire Enterprise interface. 
2. Click on the Tasks Section, enable the associated rule box, and 

click Run. 
3. Open HPE ArcSight ESM. 
4. Under Events, select Active Channels, then select Audit Events. 
5. Find the Tripwire Enterprise event logs associated with the 

event. Select Fields in the Customize dropdown and enable the 
following fields: 

a. End Time 
b. Attacker Address 
c. File Name 
d. Device Action 
e. Source User Name 
f. Device Custom String6  

6. Open IBM Spectrum Protect. 
7. Click on Restore. 
8. Select missing files and click Restore to original location. 

Expected Results (pass) Event identified (CR 1.a) 

Details of the event are understood and moment of last known good 
is identified. 
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Provide file Integrity monitor (CR 1.b). 

Modified files are correctly identified. 

Recovery complete (CR 1.c). 

System was restored to pre-DI event version.  

Actual Results Details of the event were understood and the moment of last 
known good was identified for the file in question. All the files 
affected within that timeframe were correctly identified, and a full 
and successful restore was executed.  

Overall Result Pass. All metrics of success were met to satisfaction. 
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7.1.3 Test Case Data Integrity -2 961 
Table 7-4 Test Case ID: Data Integrity -2 962 

Parent requirement (CR 2) The DI example implementation shall recover when malware 
destroys data on user’s machine. 

Testable requirement (CR 2.a) Corruption Testing, (CR 2.b) Backup Capability 

Description Show that the DI solution can recover from a DI attack that destroys 
data via a malware attack. 

Associated test cases N/A 

Associated CSF Subcategories PR.DS-1, PR.IP-4, PR-DS-6, PR.PT1 

Preconditions User downloads a malicious executable that modifies critical data. 

Procedure 1. Open the Tripwire Enterprise interface. 
2. Click on the Tasks Section, enable the associated rule box, and 

click Run. 
3. Open HPE ArcSight ESM. 
4. Under Events, select Active Channels, then select Audit Events. 
5. Find the Tripwire event logs associated with the event. Select 

Fields in the Customize dropdown and enable the following 
fields: 

a. End Time 
b. Attacker Address 
c. File Name 
d. Device Action 
e. Source User Name 
f. Device Custom String  

6. Open IBM Spectrum Protect. 
7. Click on Restore. 
8. Select missing files and click Restore to original location. 

Expected Results (pass) Provide file integrity monitor (CR 2.a). 

Modified files are correctly identified. 

Recovery complete (CR 2.b). 
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System was restored to pre-DI event version. 

Actual Results Details of the event were understood and the moment of last 
known good was identified for the file in question. All the files 
affected within that timeframe were correctly identified, and a full 
and successful restore was executed. 

Overall Result Pass. All metrics of success were met to satisfaction. 
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7.1.4 Test Case Data Integrity -3 963 
Table 7-5 Test Case ID: Data Integrity -3 964 

Parent requirement (CR 3) The DI example implementation shall recover when a user 
modifies a configuration file in violation of established baselines. 

Testable requirement (CR 3.a) Corruption Testing, (CR 3.b) Backup Capability 

 

Description Show that the DI solution can recover from a DI event that modifies 
system configurations. 

Associated test cases N/A 

Associated CSF Subcategories PR.DS-1, PR.DS-6, PR.PT-1, DE.CM-3, DE.AE-1, DE.CM-1 

Preconditions Run a script that would simulate the effects of a configuration 
modification event.  

Procedure 1. Open HP ArcSight ESM. 
2. Under Events, select Event Search. 
3. Use the search bar to search for the keyword “created” to find 

associated event logs for account creation. 
4. After determining the point in time of a malicious event, restart 

the Active Directory server, holding down the F2 and F8 keys 
while restarting to enter the Advanced Boot Options menu. 

5. Select Directory Services Repair Mode. 
6. Log in as the machine administrator. 
7. Open a command prompt. 
8. View visible backup versions with the following command: 

 wbadmin get versions 

9. Restore to a selected backup target with the following 
command. Note that the selected date should reflect the last 
known good backup: 

 wbadmin start systemstaterecovery -
version:<Version Number> -backupTarget:<Backup 
Location>  

 Replace <Version Number> with the desired version’s 
version identifier, and <Backup Location> with the 
version’s corresponding backup location. 
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10. Provide a username (with domain if applicable) and password 
for a privileged user to the backup location. 

11. Acknowledge the remaining prompts and wait for the backup to 
complete. The system will automatically restart.  

Expected Results (pass) Provide file integrity monitor (CR 3.a). 

Modified files are correctly identified. 

Recovery complete (CR 3.b). 

Modified files are restored to their original state. 

Actual Results The fake accounts were successfully identified and deleted. The 
remaining accounts were restored to their original states at the time 
of the backup.  

Overall Result Pass. All metrics of success were met to satisfaction. 
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7.1.5 Test Case Data Integrity -4 965 
Table 7-6 Test Case ID: Data Integrity -4 966 

Parent requirement (CR 4) The DI example implementation shall recover when an 
administrator modifies a user’s file. 

Testable requirement (CR 4.a) Corruption Testing, (CR 4.b) Logging, (CR 4.c) Backup 
Capability 

Description Show that the DI solution can recover from when an administrator 
modifies a user’s file. 

Associated test cases N/A 

Associated CSF Subcategories DE.AE-1, DE.AE-3, DE.AE-5 

Preconditions Two VMs on Microsoft Hyper-V have been backed up. Administrator 
accidentally runs a command that deletes a critical VM.  
Remove-VM -Name “<VMName>” -Force 

Procedure 1. Open HP ArcSight ESM. 
2. Under Events, select Event Search. 
3. Use the search bar to search for the deleted VM’s name and 

then find the associated event log. 
4. Locate previous logins from that machine by searching for the 

VM host machine’s domain and name in the search bar.  

Look for logins before the time of the deletion incident, 
without an associated logout before the event. User logins 
(as opposed to automated ones that occur constantly in the 
machine) will have a non-null value for the Source Address 
field, typically 127.0.0.1. 

5. Open the VEEAM console. 

6. Navigate to the Backups menu. 

7. Right-click on deleted VM and click Restore, and then Entire 
VM. 

8. When prompted, search for the deleted VM’s name and select it 
for restoration. 

9. When prompted, enter reason for VM restoration. 

Expected Results (pass) Provide file integrity monitor (CR 4.a). 

Missing files are correctly identified. 
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Provide user activity auditing (CR 4.b). 

User who initiated deletion is correctly identified. 

Revert to last known good (CR 4.c). 

VM is fully restored to original functionality. 

Actual Results The VEEAM system functioned as expected. Deleted VM is restored 
to its original functionality. Any user logged in during the deletion 
event was identified. 

Overall Result Pass (partial). The file integrity monitoring and reversion to last 
known good requirements were met. User activity was audited, but 
it is not possible to determine which user caused the deletion event 
if multiple users were logged in to the machine at the time of the 
event.  
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7.1.6 Test Case Data Integrity -5 967 
Table 7-7 Test Case ID: Data Integrity -5 968 

Parent requirement (CR 5) The DI example implementation shall recover when an 
administrator and/or script modifies data in a database. 

Testable requirement (CR 5.a) Logging, (CR 5.b) Backup Storage 

Description Show that the DI solution can recover when data in a database has 
been altered in error by an administrator or script. 

Associated test cases N/A 

Associated CSF Subcategories DE.AE-3, DE.AE-5 

Preconditions Run a script that would simulate the effects of an administrator or 
script modification within a database. 

Procedure 1. Open HP ArcSight ESM.  

2. Under Events, select Event Search.  

3. Use the search bar to search for the affected database and then 
find the associated event log.  

Use the field cs1 to find the affected table name and cs2 to 
find the undesired database transaction query string. 
Modify time parameters for the search to narrow the 
desired transaction. 

4. Use the duser field of the event to find the name of the user 
who executed the transaction event. 

5. Determine the number of transactions that occurred and then 
use a transactional rollback tool to restore the database to the 
last known good state.  

Expected Results (pass) Use database transaction auditing (CR 5.a). 

Bad database transaction is correctly identified. 

Roll back to last known good (CR 5.b). 

Database is restored to full functionality. 
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Actual Results The database data was successfully restored to its last known good 
state. The user responsible for the event was identified and the time 
of the event was determined. 

Overall Result Pass. All metrics of success were met to satisfaction. 
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7.1.7 Test Case Data Integrity -6 969 
Table 7-8 Test Case ID: Data Integrity -6 970 

Parent requirement (CR 6) The DI example implementation shall recover when a user 
modifies a configuration file in violation of established baselines. 

Testable requirement (CR 6.a) Corruption Testing, (CR 6.b) Backup Capability (CR 6.c). 
Provide user activity auditing. 

 

Description Show that the DI solution can recover when the database schema 
has been altered in error by an administrator or script. 

Associated test cases N/A 

Associated CSF Subcategories PR.DS-1, PR.DS-6, PR.PT-1, DE.CM-3, DE.AE-1, DE.CM-1 

Preconditions Run a script that would simulate the effects of an administrator or 
script modifying the database schema. 

Procedure 1. Open the Tripwire Enterprise interface. 

2. Click on the Tasks Section, enable the associated rule box, and 
click Run. 

3. Open HP ArcSight ESM. 

4. Under Events, select Active Channels, then select Audit Events. 

5. Find the Tripwire event logs associated with the event. Select 
Fields in the Customize dropdown and enable the following 
fields: 

a. End Time 
b. Attacker Address 
c. File Name 
d. Device Action 
e. Source User Name 
f. Device Custom String6  

6. Open SQL Server Management Studio and locate the affected 
database(s). 



DRAFT 

NIST SP 1800-11B: Data Integrity 51 

7. Right-click on the database name and select Tasks > Restore > 
Database... 

8. Verify that the Restore To: location is a backup from before the 
time of the incident.  

9. Under Options, select Overwrite the existing database (WITH 
REPLACE) 

10. Click OK and wait for the restoration to complete. 

Expected Results (pass) Provide file integrity monitor (CR 6.a). 

Modified table is correctly identified. 

Revert to last known good (CR 6.b). 

Database fully restored to previous functionality. 

Provide user activity auditing (CR 6.c). 

User who initiated the modification is correctly identified. 

Actual Results The database schema was successfully restored to its last known 
good state. The user responsible for the event was identified and 
the time of the event was determined. 

Overall Result Pass. All metrics of success were met to satisfaction. 

971 



DRAFT 

NIST SP 1800-11B: Data Integrity 52 

8 Future Build Considerations 972 

The NCCoE is considering additional DI projects that map to the Cybersecurity Framework Core 973 
Functions of Identify, Protect, Detect and Respond. This reference design focuses largely on the Recover 974 
aspect of the CSF. The functions of the CSF lead into each other and act as a cycle. Identifying 975 
vulnerabilities leads to protection against them. Protecting against vulnerabilities allows enterprises to 976 
detect cybersecurity events. Detection of events gives enterprises the information needed to respond 977 
and recover from these events as well as reshape their policy to identify and protect against events in 978 
the future. Though this project deals primarily with an organization’s capabilities to recover from DI 979 
events, future NCCoE projects may look at capabilities for meeting the requirements of the other 980 
functions in the CSF.  981 

This project does not include instructions for automated full system recovery. If malicious software 982 
manages to affect critical system files, recovery becomes more difficult. The backup software used is 983 
client-based, so the system must be able to run the client to restore, which may not be possible in some 984 
instances. Solutions exist to help automate the process to fully restore a failed system and integrate 985 
with existing backup solutions. A future build might include the use of a product to address these types 986 
of attacks.  987 

This project uses built-in database capabilities to achieve transactional rollbacks as well as database 988 
metadata restoration. The restoration process is granular and uses built-in mechanisms; however, 989 
automating the process is more difficult. Products exist that use the built-in restoration mechanisms and 990 
implement their own database backup functionality. These products add varying degrees of latency to 991 
database transactions, depending on the mechanisms used and the granularity of recovery the 992 
organization desires.993 
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Appendix A  List of Acronyms 
COI Community of Interest 

CR Capability Requirement 

CSF Cybersecurity Framework 

DI Data Integrity 

ESM Enterprise Security Manager 

HPE Hewlett Packard Enterprise 

IEC/ISO International Electrotechnical Commission/International Organization for 
Standardization 

IP Internet Protocol 

IT Information Technology  

MS SQL Microsoft Structured Query Language 

NCCoE National Cybersecurity Center of Excellence  

NIST National Institute of Standards and Technology 

OS Operating System 

SP Special Publication 

VM Virtual Machine 

WORM Write Once Read Many 
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 1 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 2 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 3 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 4 
public-private partnership enables the creation of practical cybersecurity solutions for specific 5 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 6 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 7 
Fortune 50 market leaders to smaller companies specializing in IT security—the NCCoE applies standards 8 
and best practices to develop modular, easily adaptable example cybersecurity solutions using 9 
commercially available technology. The NCCoE documents these example solutions in the NIST Special 10 
Publication 1800 series, which maps capabilities to the NIST Cyber Security Framework and details the 11 
steps needed for another entity to recreate the example solution. The NCCoE was established in 2012 by 12 
NIST in partnership with the State of Maryland and Montgomery County, Md. 13 

To learn more about the NCCoE, visit https://nccoe.nist.gov. To learn more about NIST, visit 14 
https://www.nist.gov. 15 

NIST CYBERSECURITY PRACTICE GUIDES 16 

NIST Cybersecurity Practice Guides (Special Publication Series 1800) target specific cybersecurity 17 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 18 
adoption of standards-based approaches to cybersecurity. They show members of the information 19 
security community how to implement example solutions that help them align more easily with relevant 20 
standards and best practices and provide users with the materials lists, configuration files, and other 21 
information they need to implement a similar approach. 22 

The documents in this series describe example implementations of cybersecurity practices that 23 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 24 
or mandatory practices, nor do they carry statutory authority.  25 

ABSTRACT 26 

Businesses face a near-constant threat of destructive malware, ransomware, malicious insider activities, 27 
and even honest mistakes that can alter or destroy critical data. These data corruption events could 28 
cause a significant loss to a company’s reputation, business operations, and bottom line.   29 

These types of adverse events, that ultimately impact data integrity, can compromise critical corporate 30 
information including emails, employee records, financial records, and customer data. It is imperative 31 
for organizations to recover quickly from a data integrity attack and trust the accuracy and precision of 32 
the recovered data. 33 

https://nccoe.nist.gov/
https://www.nist.gov/
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The National Cybersecurity Center of Excellence (NCCoE) at NIST built a laboratory environment to 34 
explore methods to effectively recover from a data corruption event in various Information Technology 35 
(IT) enterprise environments. NCCoE also implemented auditing and reporting IT system use to support 36 
incident recovery and investigations.  37 

This NIST Cybersecurity Practice Guide demonstrates how organizations can implement technologies to 38 
take immediate action following a data corruption event. The example solution outlined in this guide 39 
encourages effective monitoring and detection of data corruption in standard, enterprise components 40 
as well as custom applications and data composed of open-source and commercially available 41 
components. 42 
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1 Introduction 126 

The following guides show IT professionals and security engineers how we implemented this data 127 
integrity solution example. We cover all the products employed in this reference design. We do not 128 
recreate the product manufacturers’ documentation, which is presumed to be widely available. Rather, 129 
these guides show how we integrated the products into our environment. 130 

Note: These are not comprehensive tutorials. There are many possible service and security configurations 131 
for these products that are out of scope for this reference design. 132 

1.1 Practice Guide Structure 133 

This NIST Cybersecurity Practice Guide demonstrates a standards-based reference design and provides 134 
users with the information they need to replicate the data integrity solution. This reference design is 135 
modular and can be deployed in whole or in parts. 136 

This guide contains three volumes: 137 

 NIST SP 1800-11a: Executive Summary 138 

 NIST SP 1800-11b: Approach, Architecture, and Security Characteristics – what we built and why 139 

 NIST SP 1800-11c: How-To Guides – instructions for building the example solution (you are here) 140 

Depending on your role in your organization, you may use this guide in different ways: 141 

Business decision makers, including chief security and technology officers, will be interested in the 142 
Executive Summary (NIST SP 1800-11a), which describes the: 143 

 challenges enterprises face in protecting their data from loss or corruption 144 

 example solution built at the National Cybersecurity Center of Excellence (NCCoE) 145 

 benefits of adopting the example solution 146 

Technology or security program managers who are concerned with how to identify, understand, assess, 147 
and mitigate risk will be interested in this part of the guide, NIST SP 1800-11b, which describes what we 148 
did and why. The following sections will be of particular interest: 149 

 Section 3.4.1, Assessing Risk Posture, provides a description of the risk analysis we performed. 150 

 Section 3.4.2, Security Control Map, maps the security characteristics of the example solution to 151 
cybersecurity standards and best practices. 152 

Consider sharing the Executive Summary (NIST SP 1800-11a) with your leadership team to help them 153 
understand the importance of adopting standards-based data integrity solutions. 154 
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IT professionals who want to implement an approach like this will find the whole practice guide useful. 155 
You can use the How-To portion of the guide (NIST SP 1800-11c) to replicate all or parts of the build 156 
created in our lab. The guide provides specific product installation, configuration, and integration 157 
instructions for implementing the example solution. We do not recreate the product manufacturers’ 158 
documentation, which is generally widely available. Rather, we show how we integrated the products in 159 
our environment to create an example solution. 160 

This guide assumes that IT professionals have experience implementing security products within the 161 
enterprise. While we used a suite of commercial products to address this challenge, this guide does not 162 
endorse these particular products. Your organization can adopt this solution or one that adheres to 163 
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing 164 
parts of the data integrity solution. Your organization’s security experts should identify the products that 165 
will best integrate with your existing tools and IT system infrastructure. We hope you will seek products 166 
that are congruent with applicable standards and best practices.  167 

A NIST cybersecurity practice guide does not describe “the” solution, but a possible solution. This is a 168 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 169 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to  170 
di-nccoe@nist.gov. 171 

1.2 Build Overview 172 

The NCCoE built a hybrid virtual-physical laboratory environment to explore methods to effectively 173 
recover from a data corruption event in various Information Technology (IT) enterprise environments. 174 
NCCoE also explored the issues of auditing and reporting that IT systems use to support incident 175 
recovery and investigations. The servers in the virtual environment were built to the hardware 176 
specifications of their specific software components.  177 

The NCCoE worked with members of the Data Integrity Community of Interest to develop a diverse (but 178 
non-comprehensive) set of use case scenarios against which to test the reference implementation. 179 
These are detailed in Volume B, Section 5.1. For a detailed description of our architecture, see Volume 180 
B, Section 4. 181 

mailto:di-nccoe@nist.gov
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1.3 Typographical Conventions 182 

The following table presents typographic conventions used in this volume. 183 

Typeface/ Symbol Meaning Example 

Italics filenames and pathnames 
references to documents 
that are not hyperlinks, new 
terms, and placeholders 

For detailed definitions of terms, see 
the NCCoE Glossary. 

Bold names of menus, options, 
command buttons and fields 

Choose File > Edit. 

Monospace command-line input, on-
screen computer output, 
sample code examples, sta-
tus codes 

mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the doc-
ument, a web URL, or an 
email address 

All publications from NIST’s National 
Cybersecurity Center of Excellence 
are available at http://nccoe.nist.gov 

2 Product Installation Guides 184 

This section of the practice guide contains detailed instructions for installing, configuring, and 185 
integrating all the products used to build an instance of the example solution. 186 

The products presented in this document have the potential to quickly change both interfaces and 187 
functionality. This document aims to highlight the core configurations an organization could use along 188 
with visual representations of those configurations.  189 

http://nccoe.nist.gov/
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2.1 Active Directory and Domain Name System (DNS) Server 190 

As part of our enterprise emulation, we included an Active Directory server that doubles as a DNS 191 
server. This section covers the installation and configuration process used to set up Active Directory and 192 
DNS on a Windows Server 2012 R2 machine. 193 

2.1.1 Installing Features 194 
1. Open Server Manager. 195 

 196 
2. Click the link Add Roles and Features.  197 
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3. Click Next.  198 

4. Select Role-based or feature-based installation. 199 

 200 
5. Click Next. 201 
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 202 
6. Select ADDNS (or the correct Windows Server name) from the list. 203 
7. Click Next. 204 

 205 
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8. Check the box next to Active Directory Domain Services. 206 

 207 

 208 
9. Click Add Features. 209 
10. Click Next. 210 
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 211 
11. Ensure that Group Policy Management, .NET Framework 4.5, TCP Port Sharing, Remote Server 212 

Administration Tools, and Windows PowerShell are selected. 213 

 214 
12. Select any additional features and click Add Features on the popup. 215 
13. Click Next. 216 
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 217 
14. Click Next. 218 

 219 
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 220 
15. Click Install.  221 
16. Wait for the installation to complete. 222 

 223 
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17. Select Post-Deployment Configuration or Promote this server to a domain controller. 224 

 225 
18. Select Add a new forest. 226 

 227 
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19. Enter a Root domain name. Example: DI.TEST. 228 

 229 
20. Click Next.  230 

 231 
21. Select Windows Server 2012 R2 for the Forest Functional Level.  232 
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22. Select Windows Server 2012 R2 for the Domain Functional Level. 233 
23. Check the box next to DNS server and Global Catalog. 234 
24. Do not check the box next to read-only domain controller. 235 
25. Specify a password for DSRM (D@T@Integrity#1). 236 

 237 
26. Click Next. 238 
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 239 
27. Click Next. 240 

 241 
28. Verify the NetBIOS name.  242 
29. Click Next. 243 
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 244 
30. Click Next. 245 

 246 
31. Click Next. 247 
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 248 
32. Click Install. 249 

 250 
33. The server automatically reboots. 251 
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2.1.2 Creating a Certificate Authority 252 
1. Open Server Manager. 253 

 254 
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2. Click the link Add Roles and Features. 255 

 256 
3. Click Next. 257 

 258 
4. Select Role-based or feature-based installation.  259 
5. Click Next. 260 
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 261 
6. Select ADDNS (or the correct Windows Server name) from the list. 262 
7. Click Next. 263 

 264 
8. Check the box next to Active Directory Certificate Services 265 
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 266 
9. Click Add Features. 267 

 268 
10. Click Next. 269 
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 270 
11. Click Next. 271 

 272 
12. Click Next. 273 
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 274 
13. Select Certification Authority on the Role Services list.  275 
14. Click Next. 276 

 277 
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 278 
15. Click Install.  279 
16. Select Configure Active Directory Certificate Services on the destination server. 280 

 281 
17. Click Next.  282 



DRAFT 

NIST SP 1800-11C: Data Integrity  24 

18. Select Certification Authority. 283 

 284 
19. Click Next.  285 

 286 
20. Select Enterprise CA.  287 
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21. Click Next.  288 

22. Select Root CA.  289 
23. Click Next. 290 
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24. Select Create a new private key. 291 

 292 
25. Click Next.  293 
26. Select RSA#Microsoft Software Key Storage Provider. 294 
27. Enter 2048 in the box. 295 
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28. Select SHA256 from the list. 296 

 297 
29. Click Next. 298 

 299 
30. Click Next.  300 
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31. Set the time to 5 years. 301 

 302 
32. Click Next. 303 

 304 
33. Click Next. 305 
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 306 
34. Click Configure. 307 

 308 
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2.1.3 Configure Account to Add Computers to Domain 309 
1. Open the start menu.  310 
2. Type dsa.msc and run the program. 311 

 312 
3. Right click on Users in the left pane. 313 

 314 
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4. Click Delegate Control. 315 

 316 
5. Click Next. 317 

 318 
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6. Click Add to add a user or group. Example: Domain Admins. 319 

 320 
7. When finished adding users or groups, click OK. 321 

 322 
8. Click Next. 323 
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9. Choose Create a custom task to delegate. 324 

 325 
10. Click Next. 326 

 327 
11. Choose Only the following objects in the folder.  328 
12. Select the Computer Objects check box. 329 
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13. Check the box for Create selected objects in this folder. 330 
14. Check the box for Delete selected objects in this folder. 331 

 332 
15. Click Next. 333 
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16. In the Permissions List, choose Reset Password, Read and write Account Restrictions, 334 
Validated write to DNS host name, Validated write to service principal name. 335 

 336 
17. Click Next. 337 

 338 
18. Observe the successful installation and click Finish. 339 
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2.1.4 Adding Machines to the Correct Domain 340 
1. Right click network icon in task bar.  341 
2. Click Open Network and Sharing center. 342 

 343 
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3. Click the link for editing the network interface under Connections. 344 

 345 
4. Click Properties. 346 
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 347 
5. Click Internet Protocol Version 4.  348 



DRAFT 

NIST SP 1800-11C: Data Integrity  39 

 349 
6. Click Properties.  350 
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7. Set the DNS field to the field of the AD/DNS server. 351 

 352 
8. Click OK. 353 
9. Exit out of the Network and Sharing Center 354 
10. Push the start menu button.  355 
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 356 
11. Go to This PC.  357 
12. Right click in the window and choose Properties.358 

 359 
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13. Under Name, domain, and workgroup settings, click Change settings.360 

 361 
14. Click Change.... 362 
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 363 
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15. Select Domain and enter the domain specified on the AD/DNS server.364 

 365 
16. Click OK. 366 

 367 
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17. Enter the credentials of an account in AD which has the right permissions to add a group to the 368 
domain. 369 

 370 
18. Click OK a few times and restart the server when prompted. 371 

 372 
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2.1.5 Configuring Active Directory to Audit Account Activity  373 
1. Open Local Security Policy from the Start Menu. 374 

 375 
2. Open Local Policies > Audit Policy. 376 

 377 
3. Right click Audit account management.  378 
4. Select Properties. 379 
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 380 
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 381 
5. Check the boxes next to Success and Failure. 382 
6. Click OK. 383 
7. Account management activities will now be reported to Windows Event Log – Security. 384 

2.2 Microsoft Exchange Server 385 

As part of our enterprise emulation, we include a Microsoft Exchange server. This section covers the 386 
installation and configuration process used to set up Microsoft Exchange on a Windows Server 2012 R2 387 
machine. 388 

2.2.1  Install Microsoft Exchange 389 
1. Run Exchange2016-x64.exe. 390 
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 391 
2. Choose the directory for the extracted files and press OK.392 

  393 
3. Enter the directory and run setup.exe. 394 

 395 
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4. Select Connect to the Internet and check for updates.396 

 397 
5. Wait for the check to finish. 398 
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 399 
6. Click Next. 400 
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 401 
7. Wait for the copying to finish. 402 
8. Click Next.  403 
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9. Click I accept the terms in the license agreement.404 

 405 
10. Click Next.  406 
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 407 
11. Click Use Recommended Settings. 408 
12. Click Next.  409 
13. Check Mailbox role. 410 
14. Check Automatically install Windows Server roles and features that are required to install 411 

Exchange Server. 412 
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 413 
15. Click Next. 414 
16. Specify the installation path for MS Exchange. 415 
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 416 
17. Click Next.  417 
18. Specify the name for the Exchange organization. Example: DI. 418 
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19. Decide whether to apply split permissions based on the needs of the enterprise.419 

 420 
20. Click Next. 421 
21. Click No. 422 
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 423 
22. Click Next.  424 
23. Install any prerequisites listed. 425 
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24. If necessary, restart the server and re-run setup.exe, following through steps 3-22 again.426 

 427 
25. Click Install. 428 
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 429 
26. Wait for setup to complete. 430 

2.3 SharePoint Server 431 

As part of our enterprise emulation, we include a Microsoft SharePoint server. This section covers the 432 
installation and configuration process used to set up SharePoint on a Windows Server 2012 R2 machine. 433 

2.3.1  Install Roles and Features 434 
1. Open Server Manager. 435 
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 436 
2. Click Manage. 437 

 438 
3. Click Add Roles and Features. 439 
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 440 
4. Click Next. 441 
5. Choose Role-based or feature-based installation. 442 

 443 
6. Click Next. 444 
7. Choose Select a server from the server pool. 445 
8. Choose the SharePoint server from the list. 446 
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 447 
9. Click Next. 448 
10. Check Application Server Role. 449 

 450 
11. Click Next. 451 
12. Check IIS Hostable Web Core. 452 
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 453 
13. Click Next. 454 

 455 
14. Click Next. 456 
15. Check all boxes under Application Server Role Services. 457 
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 458 
16. Click Next. 459 
17. Choose Create a self-signed certificate. 460 

 461 
18. Click Next. 462 
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 463 
19. Click Next. 464 
20. Check all boxes under Web Server (IIS) Role Services. 465 

 466 
21. Click Next. 467 
22. Check Restart the destination server automatically if required. 468 
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 469 
23. Click Install. 470 
24. The server may automatically restart. 471 
25. Right click the .ISO file for SharePoint Server. 472 
26. Choose Mount. 473 

2.3.2 Install SharePoint 474 
1. Navigate to the main directory of the ISO. 475 

 476 
2. Double click pre-requisite installer. 477 
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 478 
3. Click Next.  479 
4. Click I accept the terms of the License agreement. 480 

 481 



DRAFT 

NIST SP 1800-11C: Data Integrity  69 

5. Click Next. 482 
6. Resolve any dependencies and repeat steps 2-5. 483 

 484 
7. After the successful installation, click Finish. 485 
8. The server may automatically restart.  486 
9. Remount the .ISO file for SharePoint Server. 487 
10. Navigate to the main directory of the .ISO file. 488 
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 489 
11. Double click the program called setup. 490 

 491 
12. Click Install SharePoint Server. 492 
13. Enter your product key when prompted. 493 
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 494 
14. Click Continue.  495 
15. Check I accept the terms of this agreement. 496 

 497 
16. Click Continue. 498 
17. Choose which Server Type fits your organization's purposes. 499 
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 500 
18. Click Install Now.  501 
19. Wait for the installation to finish. 502 
20. Check Run the SharePoint Products Configuration Wizard now. 503 

 504 
21. Click Close. 505 
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2.3.3 SharePoint Products Configuration Wizard 506 

 507 
1. Click Next.  508 

 509 
2. Click Yes.  510 
3. Click Next. 511 
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4. Wait for the configuration to complete (it may take up to 30 minutes depending on your 512 
system). 513 

 514 
5. Click Finish. 515 

2.3.4 Configure SharePoint 516 
1. Open a browser and navigate to http://sharepoint (replace sharepoint with the hostname or IP 517 

address of the SharePoint server). 518 
2. Choose the type of SharePoint template that fits your business needs. Example: Enterprise > 519 

Document Center. 520 
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 521 

2.4 Windows Server Hyper-V Role 522 

As part of our simulated enterprise, we include a Windows Hyper-V server. This section covers the 523 
instructions for installing Windows Server Hyper-V on a Windows Server 2012 R2 machine. 524 

The instructions for enabling the Windows Server Hyper-V Role are retrieved from 525 
https://technet.microsoft.com/en-us/library/hh846766(v=ws.11).aspx and are replicated below for 526 
preservation and ease of use. 527 

2.4.1 Production Installation 528 
1. In Server Manager, on the Manage menu, click Add Roles and Features. 529 

https://technet.microsoft.com/en-us/library/hh846766(v=ws.11).aspx
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 530 
2. On the Before you begin page, verify that your destination server and network environment are 531 

prepared for the role and feature you want to install.  532 

 533 
3. Click Next. 534 
4. On the Select installation type page, select Role-based or feature-based installation. 535 
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 536 
5. Click Next. 537 
6. On the Select destination server page, select a server from the server pool. 538 

 539 
7. Click Next. 540 
8. On the Select server roles page, select Hyper-V. 541 
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9. To add the tools that you use to create and manage virtual machines, click Add Features. 542 

 543 
10. Click Next. 544 

 545 
11. Click Next. 546 
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 547 
12. Click Next. 548 
13. On the Create Virtual Switches page, select the appropriate options. 549 

 550 
14. Click Next.  551 
15. On the Virtual Machine Migration page, select the appropriate options. 552 
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 553 
16. Click Next. 554 
17. On the Default Stores page, select the appropriate options. 555 

 556 
18. Click Next.  557 
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19. On the Confirm installation selections page, select Restart the destination server automatically 558 
if required. 559 

 560 
20. Click Install. 561 
21. When installation is finished, verify that Hyper-V installed correctly. Open the All Servers page in 562 

Server Manager, select a server on which you installed Hyper-V. Check the Roles and 563 
Features tile on the page for the selected server. 564 

2.5 MS SQL Server 565 

As part of both our enterprise emulation and data integrity solution, we include a Microsoft SQL Server. 566 
This section covers the installation and configuration process used to set up Microsoft SQL Server on a 567 
Windows Server 2012 R2 machine. 568 

2.5.1  Install and Configure MS SQL 569 
1. Acquire SQL Server 2014 Installation Media. 570 
2. Locate the installation media in the machine and click on SQL2014_x64_ENU to launch SQL 571 

Server Installation Center. 572 
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 573 
3. On the left menu, select Installation. 574 

 575 
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4. Select New SQL Server stand-alone installation or add features to an existing installation. This 576 
will launch the SQL Server 2014 setup. 577 

 578 
5. In the Product Key section, enter your product key. 579 
6. Click Next. 580 
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 581 
7. In the License Terms section, read and click I accept the license terms. 582 
8. Click Next.  583 
9. In the Install Rules section, note and resolve any further conflicts.  584 
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 585 
10. Click Next. 586 
11. In the Setup Role section, select SQL Server Feature Installation.  587 

 588 
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12. Click Next. 589 
13. In the Feature Selection section, select the following: 590 

a. Database Engine Services 591 
b. Client Tools Connectivity 592 
c. Client Tools Backwards Compatibility 593 
d. Client Tools SDK 594 
e. Management Tools – Basic 595 
f. Management Tools – Complete 596 
g. SQL Client Connectivity SDK 597 
h. Any other desired features 598 

 599 
14. Click Next. 600 
15. In the Instance Configuration section, select Default instance. 601 
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 602 
16. Click Next. 603 

 604 
17. In the Server Configuration section, click Next. 605 
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18. In the Database Engine Configuration section, make sure Mixed Mode is selected. 606 
19. Add all desired users as Administrators under Specify SQL Server Administrators by pressing 607 

Add Current User. 608 
a. For Domain accounts, simply type in $DOMAINNAME\$USERNAME into Enter the 609 

object names to select textbox. 610 
b. Click OK. 611 
c. For local computer accounts, click on locations and select the computers name. 612 
d. Click OK. 613 
e. Type the username into the Enter the object names to select textbox. 614 
f. Once you are finished adding users, click Next. 615 

 616 

20. In the Ready to install section, verify the installation and click Install. 617 
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 618 
21. Wait for the install to finish.  619 

 620 
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2.5.2 Open Port on Firewall 621 
1. Open Windows Firewall with Advanced Security. 622 

 623 
2. Click Inbound Rules and then New Rule. 624 
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 625 
3. Select Port. 626 
4. Click Next.  627 
5. Select TCP and Specific local ports. 628 
6. Type 1433 into the text field. 629 
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 630 
7. Click Next. 631 
8. Select Allow the connection. 632 
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 633 
9. Click Next. 634 
10. Select all applicable locations. 635 
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 636 
11. Click Next.  637 
12. Name the rule Allow SQL Access. 638 
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 639 
13. Click Finish. 640 

2.5.3 Add a New Login to the Database 641 
1. Open SQL Server Management Studio. 642 

 643 
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2. Hit Connect to connect to the database. 644 
3. In the Object Explorer window, expand the Security folder. 645 

 646 
4. Right click on the Logins folder and click New Login…. 647 
5. Input the desired user. 648 

 649 
6. Click OK. 650 
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2.6 HPE ArcSight Enterprise Security Manager (ESM) 651 

HPE ArcSight Enterprise Security Manager is primarily a log collection/analysis tool with features for 652 
sorting, filtering, correlating, and reporting information from logs. It is adaptable to logs generated by 653 
various systems, applications, and security solutions.  654 

This installation guide assumes a pre-configured CentOS 7 Virtual Machine with ESM already installed 655 
and licensed. This section covers the installation and configuration process used to set up ArcSight 656 
agents on various machines. 657 

2.6.1 Install Individual ArcSight Windows Connectors 658 
1. Log in to your DNS server. 659 

 660 
2. Add the host name of the ESM server vm-esm691c to the DNS list and associate it with the IP 661 

address of the ESM server. 662 
3. Run the installation file ArcSight-7.4.0.7963.0-Connector-Win64. 663 
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 664 
4. Wait for the initial setup to finish. 665 

 666 
5. Click Next. 667 
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6. Choose a destination folder. Note: It is recommended to change the default destination folder 668 
to <default>\Windows. This is to avoid conflicts if you wish to install more than one connector. 669 

 670 
7. Click Next. 671 

 672 
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8. Click Next. 673 

 674 
9. Click Install. 675 
10. Wait for the installation to finish. 676 
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 677 
11. Select Add a Connector. 678 
12. Click Next. 679 
13. Choose Microsoft Windows Event Log - Native from the list. 680 
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 681 
14. Click Next. 682 
15. Check Security log, System log, and Application Log. 683 
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 684 
16. Click Next. 685 
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 686 
17. Click Next. 687 
18. Choose ArcSight Manager (encrypted). 688 
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 689 
19. Click Next. 690 
20. For Manager Hostname, put vm-esm691c, or the hostname of your ESM server. 691 
21. For Manager Port, put 8443 (or the port that ESM is running on) on the ESM server. 692 
22. Enter the username and password used for logging into ArcSight Command Center. Default: 693 

(admin/password) 694 
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 695 
23. Click Next. 696 
24. Set identifying details about the system to help identify the connector (include a value for 697 

Name; the rest is optional). 698 
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 699 
25. Click Next. 700 
26. Select Import the certificate to connector from destination. This will fail if the Manager 701 

Hostname does not match the hostname of the Virtual Machine. 702 
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 703 
27. Click Next. 704 
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 705 
28. Click Next. 706 
29. Choose Install as a service. 707 



DRAFT 

NIST SP 1800-11C: Data Integrity  110 

 708 
30. Click Next.  709 



DRAFT 

NIST SP 1800-11C: Data Integrity  111 

 710 
31. Click Next. 711 
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 712 
32. Click Next.  713 
33. Choose Exit. 714 
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 715 
34. Click Next.  716 

 717 
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35. Click Done. 718 
36. Open Task Manager. 719 
37. Click More Details. 720 

 721 
38. Go to the Services tab. 722 
39. Find the service just created for ArcSight and right click it. 723 
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 724 
40. Choose Start. 725 
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 726 
41. The machine will now report its logs to ArcSight ESM. 727 

2.6.2 Install a Connector Server for ESM on Windows 2012 R2 728 
1. Run the installation file ArcSight-7.4.0.7963.0-Connector-Win64. 729 
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 730 
2. Wait for the initial setup to finish. 731 

 732 
3. Click Next. 733 
4. Choose a destination folder. Note: It is recommended to change the default destination folder 734 

to <default>\Windows. This is to avoid conflicts if you wish to install more than one connector. 735 
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 736 
5. Click Next. 737 

 738 
6. Click Next. 739 
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 740 
7. Click Install. 741 
8. Wait for the installation to finish. 742 
9. Select Add a Connector. 743 

 744 
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10. Click Next. 745 
11. Choose Microsoft Windows Event Log - Native from the list. 746 

 747 
12. Click Next. 748 
13. Check Security log, System log, Application Log. 749 
14. Check Use Active Directory. 750 
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 751 
15. Click Next. 752 
16. Fill out the form with the appropriate information for your Active Directory server. It is 753 

recommended to create an account on Active Directory specifically for ArcSight. 754 
17. Select Replace Hosts for Use Active Directory host results for. 755 
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 756 
18. Click Next. 757 
19. Select all the event types you would like forwarded from each machine. 758 

 759 
20. Click Next. 760 
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 761 
21. Click Next. 762 
22. Choose ArcSight Manager (encrypted). 763 

 764 
23. Click Next. 765 
24. For Manager Hostname, use vm-esm691c or the hostname of your ESM server. 766 
25. For Manager Port, use 8443 (or the port that ESM is running on) on the ESM server. 767 
26. Enter the username and password used for logging into ArcSight Command Center. Default: 768 

(admin/password) 769 
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 770 
27. Click Next. 771 
28. Set identifying details about the system to help identify the connector (include Name; the rest is 772 

optional). 773 

 774 
29. Click Next. 775 
30. Select Import the certificate to connector from destination. This will fail if the Manager 776 

Hostname does not match the hostname of the VM. 777 
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 778 
31. Click Next. 779 

 780 
32. Click Next. 781 
33. Choose Install as a service. 782 
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 783 
34. Click Next.  784 
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 785 
35. Click Next.  786 
36. Choose Exit. 787 
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 788 
37. Click Next. 789 

 790 
38. Click Done. 791 
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39. Open Task Manager. 792 
40. Click More Details. 793 

 794 
41. Go to the Services tab. 795 
42. Find the service just created for ArcSight and right click it. 796 
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 797 
43. Choose Start. 798 
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 799 
44. The machine will now report all collected Windows logs to ArcSight ESM. 800 

2.6.3 Install Syslog Connector for Ubuntu 801 
1. Run ./ArcSight-7.4.0.7963.0-Connector-Linux64.bin. 802 
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 803 
2. Click Next. 804 
3. Choose a folder to install the connector in. 805 

 806 
4. Click Next. 807 
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 808 
5. Click Next. 809 

 810 
6. Click Install. 811 
7. Choose Add a Connector. 812 
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 813 
8. Click Next. 814 
9. Choose Syslog File. 815 
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 816 
10. Click Next. 817 
11. For File Absolute Path Name, select a log file from which to forward events to ESM. Example: 818 

/var/log/syslog 819 
12. Select realtime to have events be streamed or batch to have events sent over in sets. 820 
13. For Action upon Reaching EOF, select None. 821 
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 822 
14. Click Next. 823 
15. Select ArcSight Manager (encrypted). 824 
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 825 
16. Click Next. 826 
17. For Manager Hostname, put vm-esm691c or the hostname of your ESM server. (You may need 827 

to add dns-search.di.test to /etc/network/interfaces if the hostname does not resolve on its 828 
own. For example, vm-esm691c.di.test may resolve but vm-esm691c may not.) 829 

18. For Manager Port, put 8443 (or the port that ESM is running on) on the ESM server. 830 
19. Enter the username and password used for logging into ArcSight Command Center. Default: 831 

(admin/password) 832 
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 833 
20. Click Next. 834 
21. Set identifying details about the system to help identify the connector (include Name; the rest is 835 

optional). 836 
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 837 
22. Click Next. 838 
23. Choose Import the certificate to connector from destination. 839 
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 840 
24. Click Next. 841 
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 842 
25. Click Next. 843 
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  844 
26. Click Next. 845 
27. Choose Exit. 846 
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 847 
28. Click Next. 848 

 849 
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29. Click Done. 850 

2.7 IBM Spectrum Protect  851 

IBM Spectrum Protect is a backup/restore solution that makes use of cloud-based object storage. It 852 
allows for administrative management of backups across an enterprise, providing users with 853 
mechanisms to restore their data on a file level. This section covers the installation and configuration 854 
process used to set up IBM Spectrum Protect on a Windows Server 2012 R2 machine, as well as the 855 
installation and configuration processes required for installing the backup/archive client on various 856 
machines. 857 

2.7.1 Install IBM Spectrum Protect Server 858 
1. You may need to disable Run all administrators in Admin Approval Mode. To do this go to 859 

Control Panel > Administrative Tools > Local Security Policy > Local Policies > Security 860 
Options. Double click the User Account Control: Run all administrators in Admin Approval 861 
Mode section. Select Disable and click OK. Restart the computer. 862 

863 
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864 

865 
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 866 
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2. Run WIN_SER_STG_ML in its own folder to extract the contents.867 

 868 
3. Run the install script.  869 
4. Make sure all the boxes are checked. 870 

 871 
5. Click Next.  872 



DRAFT 

NIST SP 1800-11C: Data Integrity  148 

6. Read and select I accept the terms in the license agreement. 873 

 874 
7. Click Next.  875 
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8. Select the location for files to be installed to. 876 

 877 
9. Click Next. 878 

 879 
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10. Click Next. 880 
11. Make sure all the packages are checked. 881 

 882 
12. Click Next. 883 
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13. Select IBM Spectrum Protect.884 

 885 
14. Click Next.  886 
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15. Read and select I accept the terms in the license agreement.887 

 888 
16. Click Next.  889 
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17. Read and select I accept the terms in the license agreement.890 

 891 
18. Click Next. 892 
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19. Specify 11090 for the port. 893 

 894 
20. Click Next.  895 
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21. Select Strict for the SP800-131a Compliance.896 

 897 
22. Click Next.  898 
23. Create a password. 899 
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 900 

24. Click Next.  901 

 902 



DRAFT 

NIST SP 1800-11C: Data Integrity  157 

25. Click Install. 903 
26. Wait for the install to finish. 904 

 905 

27. Click Finish. 906 
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 907 

2.7.2 Install IBM Spectrum Protect Client Management Services 908 
1. Run WIN64_CMS_ML in its own folder to extract the contents.909 

 910 
2. Run the install script. 911 
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 912 
3. Click Install. 913 
4. Check the box next to IBM Spectrum Protect Client Management Services.914 

 915 
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5. Click Next. 916 
6. Select Use the existing package group.917 

 918 
7. Click Next. 919 
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8. Make sure all the boxes next to the package Client Management Services are checked.920 

 921 
9. Click Next.  922 
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10. Set the port to 9028.923 

 924 
11. Click Next.  925 
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12. Click Strict for SP800-131a compliance.926 

 927 
13. Click Next. 928 

 929 
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14. Click Install. 930 

 931 

15. Observe the successful installation and click Finish. 932 
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2.7.3 Configure IBM Spectrum Protect 933 
1. Go to Start > IBM Spectrum Protect Configuration Wizard.934 

 935 
2. Click OK. 936 
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 937 
3. Click Next. 938 
4. Specify a name and an account for the IBM server to use. Example: (name: BACKSRVR, User ID: 939 

DI\spadmin). 940 
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 941 
5. Click Next. 942 
6. Choose a directory. 943 

 944 
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7. Click Next. 945 
8. Click Yes if prompted to create the directory. 946 
9. Choose The database directories are listed below. 947 
10. Create a directory to contain the database. Example: C:\BACKSRVR\IBMBackupServer. 948 
11. Enter the directory in the space provided.949 

 950 
12. Click Next. 951 
13. Create directories for logs and archive logs. Example: C:\BACKSRVR\IBMBackupServerLogs, 952 

C:\BACKSRVR\IBMBackupServerArchiveLogs. 953 
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14. Enter the directories in their respective fields.954 

 955 
15. Click Next. 956 
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16. Specify the server name. 957 

 958 
17. Click Next. 959 
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18. Specify an Administrator account.960 

 961 
19. Click Next.  962 
20. Select a port. Example: 1500. 963 
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21. Check the box next to Enable SSL Communication and enter a port. Example: 23444.964 

 965 
22. Click Next. 966 

 967 
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23. Click Next.  968 
24. Wait for the installation to finish.969 

 970 
25. Click Next. 971 
26. Click Done. 972 
27. Log in to Operations Center by going to localhost:11090/oc/. If issues occur, check firewall 973 

permissions for ports 1500 and 23444 (or whichever ports were designated in steps 20 and 21).974 

 975 
28. Log in using the credentials provided in the Configuration Wizard. 976 
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29. Enter the password for a new account to be created on the system.977 

 978 
30. Click Next. 979 
31. Select the time interval for data collection.980 

 981 
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32. Click Next. 982 
33. Select time intervals that suit your organization's needs.983 

 984 
34. Click Configure. 985 

 986 
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2.7.4 Adding Clients to IBM Spectrum Protect 987 
1. Log in to Operations Center.988 

 989 
2. Add clients by clicking the Clients tab.990 

 991 
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3. Click +Client.\ 992 

 993 
4. Select the server running the IBM backup capabilities. 994 
5. Check the box next to Always use for SSL.995 

 996 
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6. Click Next.  997 
7. Enter the name of a client machine that you want to be able to backup data from and a 998 

password. 999 
8. Decide whether to use Client-side deduplication (it reduces the required storage space for 1000 

backups). 1001 

 1002 
9. Click Next. Note the information on the next page as it is required to connect the server to the 1003 

client. 1004 
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 1005 
10. Click Next. 1006 

 1007 
11. Click Next. 1008 
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 1009 
12. Click Next. 1010 

 1011 
13. Click Next.  1012 
14. Select Default. 1013 
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 1014 
15. Click Add Client. 1015 

 1016 
16. Make sure to allow the ports for SSL and TCP traffic through the firewall (23444, 1500). 1017 
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17. Run the following command to set cert256.arm as the default certificate on the IBM Backup 1018 
server. Execute this command from the root server directory. Example: C:\Program 1019 
Files\Tivoli\TSM\BACKSRVR 1020 

> gsk8capicmd_64 -cert -setdefault -db cert.kdb -stashed -label "TSM Server 1021 
SelfSigned SHA Key" 1022 

Note: By default, gsk8capicmd_64 is located at C:\Program Files\Common 1023 
Files\Tivoli\TSM\api64\gsk8\bin. 1024 

 1025 
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2.7.5 Install the Spectrum Protect Client on Windows 1026 
1. Extract SP_CLIENT_8.1_WIN_ML 1027 

 1028 
2. Run the spinstall script (install any prerequisites required).1029 

 1030 
3. Click Next. 1031 
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4. Specify an installation path.1032 

 1033 
5. Click Next.  1034 
6. Select Custom Install. 1035 

 1036 
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7. Click Next. Make sure that all packages are selected for installation.1037 

 1038 
8. Click Next. 1039 

 1040 
9. Click Install. 1041 
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 1042 
10. Click Finish. 1043 
11. Run Backup-Archive GUI from the Start menu. This should open the IBM Spectrum Protect 1044 

Client Configuration Wizard.1045 

 1046 
12. Click Next.  1047 
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13. Select Create a new options file.1048 

 1049 
14. Click Next.  1050 
15. Enter the Node Name that you created in the Operations Center. 1051 

 1052 
16. Click Next.  1053 
17. If prompted, allow the program through the firewall.  1054 
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18. Select TCP/IP for the communication method.1055 

 1056 
19. Click Next. 1057 
20. Specify the IP address of the server running the IBM backup server.  1058 
21. Specify the port that the server is accepting connections on (Example: 23444).1059 

 1060 
22. Click Next.  1061 
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23. Click Select All or choose specific items from the recommended list of inclusions/exclusions. 1062 

 1063 
24. Click Next.  1064 
25. Select certain file types to exclude from backup, if any.1065 

 1066 
26. Click Next.  1067 
27. Check the box next to Backup all local file systems. 1068 
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28. Select Incremental for the Backup Type.1069 

 1070 
29. Click Next. 1071 

 1072 
30. Click Apply.  1073 
31. Click Finish.  1074 
32. In the Backup-Archive GUI (you may have to log in using the credentials specified on the server 1075 

or you may have to choose to ignore a warning that you couldn't connect), go to Edit > Client 1076 
Preferences. 1077 
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 1078 
33. Click Communication. 1079 
34. Ensure that the server address is correct and that the ports point to your SSL port (23444). 1080 
35. Check the boxes next to Send transaction to the server immediately, Use Secure Sockets Layer 1081 

(SSL), and Require TLS 1.2 or above. 1082 
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36. Select Yes for SSL is Required.1083 

 1084 
37. Click OK. 1085 
38. Retrieve cert256.arm from the server. 1086 
39. On the client machine, create a new key database by running the following commands: 1087 

> set PATH=C:\Program Files\Common 1088 
Files\Tivoli\TSM\api64\gsk8\bin\;C:\Program Files\Common 1089 
Files\Tivoli\TSM\api64\gsk8\lib64;%PATH% 1090 

> gsk8capicmd_64 -keydb -create -populate -db dsmcert.kdb -pw password -1091 
stash 1092 
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 1093 

40. Import cert256.arm by running the command: 1094 

> gsk8capicmd_64 -cert -add -db dsmcert.kdb -stashed -label "TSM server 1095 
BACKSRVR self-signed key" -file <path-to-cert256.arm> -format asci 1096 

 1097 
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41. Copy the resulting dsmcert.kdb and dsmcert.sth to C:\Program Files\Tivoli\TSM\baclient.1098 

 1099 

2.7.6 Install the Spectrum Protect Client on Ubuntu 1100 
1. Extract SP_CLIENT_8.1_LIN86_ML.tar.gz.1101 

 1102 
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2. Navigate to TSMCLI_LNX/tsmcli/linux86_DEB.1103 

 1104 
3. Install all the .deb files in this directory, except tivsm-jbb.amd64.deb, by running the following 1105 

command (they must be dpkg'd individually since they have interdependencies): 1106 
a. dpkg -i [name of package].deb 1107 

 1108 
4. Issue the following commands to setup the options files: 1109 

a. cd /opt/tivoli/tsm/client/ba/bin 1110 
b. mv dsm.sys.smp dsm.sys 1111 
c. mv dsm.opt.smp dsm.opt 1112 
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 1113 
5. Install Java with: 1114 

a. sudo apt-get install default-jre 1115 

 1116 
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6. Run dsmj to start the Java BAClient. 1117 

 1118 
7. After about 5 minutes, it will be unable to connect and will ask if you wish to start the client  1119 

anyway. Click Yes. 1120 

 1121 
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8. Open Edit > Client Preferences. Enter the node name as the name of the client you added to the 1122 
Spectrum Protect server.1123 

 1124 
9. Click the Communication tab. 1125 
10. Enter the IP Address for the server. 1126 
11. Enter the Server port and Admin port (23444). 1127 
12. Check the boxes next to Send transaction to the server immediately, Use Secure Sockets Layer 1128 

(SSL), and Require TLS 1.2 or above. 1129 
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13. Select Yes for SSL is Required.1130 

 1131 
14. Click OK.  1132 
15. Retrieve cert256.arm from the server. 1133 
16. On the client machine create a new key database by running the following commands: 1134 

> gsk8capicmd_64 -keydb -create -populate -db dsmcert.kdb -pw password -1135 
stash 1136 
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 1137 

17. Import cert256.arm by running the command: 1138 

> gsk8capicmd_64 -cert -add -db dsmcert.kdb -stashed -label "TSM server 1139 
BACKSRVR self-signed key" -file <path-to-cert256.arm> -format asci 1140 

 1141 
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18. Copy the resulting "dsmcert.kdb" and "dsmcert.sth" to /opt/tivoli/tsm/client/ba/bin.1142 

 1143 
19. You may be asked to reconfigure the dsm.opt file when setting up the scheduler but the options 1144 

should be filled out already.  1145 
20. To start the scheduler as a background process, run the following command: 1146 

> nohup dsmc schedule 2>/dev/null & 1147 

 1148 

21. You can add this command to the startup programs in Ubuntu to make it start automatically. 1149 

2.8 GreenTec WORMdisks 1150 

See the Installation of GreenTec Command Line Utilities document, that should accompany the 1151 
installation disk, for a detailed guide on how to install the GreenTec command line utilities. 1152 
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Furthermore, refer to the GT_WinStatus User Guide , that should also accompany the installation disk, 1153 
for instructions on how to effectively use GreenTec disks to preserve data. Read these instructions 1154 
carefully, as locking GreenTec WORMdisks can result in making some or all of the disk or the entire disk 1155 
unusable. Having portions of the disk, or the entire disk, permanently locked is sometimes desirable but 1156 
it is dependent on the needs of your organization. For example, if you want to store backup information 1157 
or logs securely.  1158 

 1159 

The GT_WinStatus User Guide provides instructions for locking and temporarily locking disk sectors. In 1160 
this practice guide, we will not include instructions on when or how to lock GreenTec disks. However, in 1161 
some cases, we will provide instructions detailing how to save data to these disks and leave locking 1162 
them to the implementing parties. 1163 

2.9 Veeam Backup & Replication 1164 

Veeam’s Backup & Replication tool provides backup and restore capabilities. In the data integrity 1165 
solution, Veeam is used to backup and restore virtual machines residing within Windows Server Hyper-1166 
V. In this section is the installation and configuration process for Veeam Backup & Replication on a 1167 
Windows Server 2012 R2 machine. Additional installation and configuration instructions can be found at 1168 
https://helpcenter.veeam.com/docs/backup/hyperv/install_vbr.html?ver=95. 1169 

2.9.1 Production Installation 1170 
1. Start the Veeam Setup Wizard and click to begin the installation process for Veeam Backup & 1171 

Replication with the appropriate version number. 1172 

https://helpcenter.veeam.com/docs/backup/hyperv/install_vbr.html?ver=95
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 1173 
2. Read and accept the license agreement. 1174 

 1175 
3. Click Next. 1176 
4. Browse to the location of the license file. 1177 
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 1178 
5. Click Next. 1179 
6. Select installation components required by your organization. 1180 

 1181 
7. Click Next. 1182 
8. Specify account credentials for Service account. 1183 
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 1184 
9. Click Next. 1185 
10. Specify details of the SQL Server Instance. 1186 

 1187 
11. Click Next. 1188 
12. Specify port numbers for Veaam Backup & Replication services. 1189 
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 1190 
13. Click Next. 1191 
14. Specify data storage locations. 1192 

 1193 
15. Click Next. 1194 
16. Review installation and configuration details and click Install. 1195 
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 1196 
17. Observe the successful installation and click Finish. 1197 

 1198 
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2.10  Tripwire Enterprise and Tripwire Log Center (TLC) 1199 

Tripwire Enterprise is a data integrity solution that monitors file activity and associated information 1200 
across an enterprise. In this solution, we use it to monitor both a MS SQL database and file changes in 1201 
certain folders. Tripwire Log Center allows for the collection and standardization of logs produced by 1202 
Tripwire Enterprise. 1203 

Please see the Tripwire Enterprise Install and Maintenance Guide, accessible at 1204 
http://download.tripwire.com/te_en/docs852/te_install_and_maint_guide.pdf?V2ymLyYUTw_9Yx-1205 
EB3c3uKKO7JcgvOihm3YK_zuCGJtyYm5c9NPiogn8hIakZL3NlLqa, for a detailed, illustrated guide to the 1206 
installation. The only addition to this documentation is that the MS SQL Server should be in “Mixed 1207 
Mode” for authentication purposes. This section covers the installation and configuration process we 1208 
used to set up Tripwire Agents on various machines as well as the installation and integration of Tripwire 1209 
Log Center with Tripwire Enterprise. The result of this integration is the generation and forwarding of 1210 
events from Tripwire Enterprise to Tripwire Log Center.  1211 

2.10.1 Install Tripwire Agent on Windows 1212 
1. Run te_agent.msi on the client machine. 1213 

 1214 
2. Click Next.  1215 
3. Accept the license agreement. 1216 

http://download.tripwire.com/te_en/docs852/te_install_and_maint_guide.pdf?V2ymLyYUTw_9Yx-EB3c3uKKO7JcgvOihm3YK_zuCGJtyYm5c9NPiogn8hIakZL3NlLqa
http://download.tripwire.com/te_en/docs852/te_install_and_maint_guide.pdf?V2ymLyYUTw_9Yx-EB3c3uKKO7JcgvOihm3YK_zuCGJtyYm5c9NPiogn8hIakZL3NlLqa


DRAFT 

NIST SP 1800-11C: Data Integrity  209 

 1217 
4. Click Next. 1218 
5. Specify the installation path. 1219 
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 1220 
6. Click Next.  1221 
7. Enter the IP address of the Tripwire server.  1222 



DRAFT 

NIST SP 1800-11C: Data Integrity  211 

 1223 
8. Click Next.  1224 
9. Leave the proxy settings blank. 1225 
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 1226 
10. Click Next. 1227 
11. Enter the services password specified in the server upon installation twice.  1228 
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 1229 
12. Click Next. 1230 

 1231 
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13. Click Install.  1232 
14. Start Tripwire Agent from the start menu (on some systems it may start automatically - check 1233 

services.msc to verify that it is running). 1234 

2.10.2  Install Tripwire Agent on Ubuntu 1235 
1. Execute the following commands as root. 1236 
2. Run te_agent.bin by issuing the command: 1237 

a. ./te_agent.bin 1238 

 1239 
3. Press Enter repeatedly to read through the EULA. 1240 

 1241 
4. Enter Y to accept the EULA. 1242 
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 1243 
5. Press Enter. 1244 
6. Enter the IP address of the Tripwire server.  1245 

 1246 
7. Press Enter. 1247 
8. Enter Y if the address was entered correctly. 1248 



DRAFT 

NIST SP 1800-11C: Data Integrity  216 

 1249 
9. Press Enter. 1250 

 1251 
10. Press Enter. 1252 
11. Enter Y to use the default port number. 1253 
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 1254 
12. Press Enter. 1255 
13. Enter N to disable the use of the Federal Information Processing Standard (FIPS), unless your 1256 

system requires the use of FIPS. 1257 

 1258 
14. Press Enter. 1259 
15. Enter the services password twice, pressing Enter after each time. Note that no text will appear 1260 

while typing the password. 1261 
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 1262 
16. Press Enter to skip using a proxy.  1263 

 1264 
17. Press Y. 1265 
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 1266 
18. Press Enter.  1267 
19. Press Y to install Real Time Monitoring. 1268 

 1269 
20. Press Enter. 1270 
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 1271 
21. Press Enter to accept the default port. 1272 
22. Press Y. 1273 

 1274 
23. Press Enter. 1275 
24. The agent should install. 1276 
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 1277 
25. Run the following commands as root: 1278 

b. cd "/usr/local/tripwire/te/agent/bin" 1279 

 1280 
c. ./twdaemon start 1281 
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 1282 

26. You may need to change /etc/hosts in Debian systems if there is a line which looks like this: 1283 

127.0.1.1    <hostname> 1284 

Change this to: 1285 

 <IP of machine>    <hostname> 1286 

 Otherwise, Tripwire Enterprise may consider multiple Debian machines as the same machine in 1287 
the assets view of Tripwire Enterprise. 1288 

 1289 
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2.10.3  Install Tripwire Log Center 1290 
See the Tripwire Log Center 7.2.4 Installation Guide that should accompany the installation media for 1291 
instructions on how to install TLC. Use the Tripwire Log Center Manager installer.  1292 

Notes:  1293 

a. It is recommended that you install Tripwire Log Center on a separate system from Tripwire 1294 
Enterprise.  1295 

b. You will need to install JRE8 and the Crypto library. Instructions are also in the Tripwire Log 1296 
Center Installation Guide. 1297 

c. You may need to unblock port 9898 on your firewall for the Tripwire enterprise agents.  1298 
d. Do not install PostgreSQL if you wish to use a database on another system. 1299 
e. When it finishes installing there should be a configuration wizard.  1300 

2.10.4  Configure Tripwire Log Center 1301 
1. Click Start. 1302 

 1303 
2. Click New Install. 1304 
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 1305 
3. Click Authorize. 1306 
4. An error may appear asking you to install .NET 3.5. 1307 
5. To do this, open Server Manager. 1308 
6. Click Manage. 1309 
7. Click Add Roles and Features. 1310 
8. Click Next. 1311 
9. Select Role-based or feature-based installation. 1312 
10. Click Next. 1313 
11. Select the current server from the list. 1314 
12. Click Next.  1315 
13. Click Next. 1316 
14. Check the box next to .NET Framework 3.5 Features. 1317 
15. Click Install. 1318 
16. Wait for the installation to finish.  1319 
17. If prompted, enter Name, Organization, Serial Number, and email address in the fields. Click 1320 

Register. This step will not appear if the software has already been registered 1321 
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 1322 
18. Click Close.  1323 
19. Continue with the configuration wizard.  1324 
20. Enter appropriate details for your Database Software. 1325 
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 1326 
21. Select Use Windows Authentication. 1327 
22. Click Next. 1328 
23. Select a directory to store log messages in. Example: C:\Program Files\Tripwire\Tripwire Log 1329 

Center Manager\Logs\AUDIT 1330 
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 1331 
24. Click Next.  1332 
25. Create an Administrator password and enter it twice. 1333 
26. Enter your email address.  1334 
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 1335 
27. Click Next.  1336 
28. Select authenticate with the local windows system user account. 1337 
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 1338 
29. Click Next.  1339 
30. Select any log sources that you expect to collect using Tripwire Log Center. Examples: Tripwire 1340 

Enterprise, Windows 10, Tripwire IP360 VnE, Linux Debian, Linux Ubuntu, Microsoft Exchange, 1341 
Microsoft SQL Server. 1342 
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 1343 
31. Click Next. 1344 
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 1345 
32. Click Start. 1346 
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 1347 
33. Click Next when the configuration finishes. 1348 
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 1349 
34. Observe the successful installation and click Finish.  1350 

2.10.5  Install Tripwire Log Center Console 1351 
See chapter 4 of Tripwire Log Center 7.2.4 installation guide for instructions on how to install Tripwire 1352 
Log Center Console. Use the Tripwire Log Center Console installer. This can be done on any system, 1353 
even the system running.  1354 

2.10.6  Integrate Tripwire Log Center Tripwire Log Center with Tripwire Enterprise 1355 
1. Create a user account in Tripwire Log Center by logging into Tripwire Log Center Console.  1356 
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 1357 
2. Click the Administration Manager button. 1358 

 1359 
3. On the side bar, click User Accounts. 1360 
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 1361 
4. Click the Add button. 1362 
5. Enter the details of the user.  1363 

 1364 
6. Double click the user account.  1365 
7. Select the Permissions tab.  1366 
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 1367 
8. Click Change User Permissions. 1368 
9. Select Databases and check the box. 1369 
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 1370 
10. Select API and check the box.  1371 

 1372 

11. Click OK. 1373 
12. Click OK. 1374 
13. Click OK. 1375 
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 1376 
14. Open Tripwire Enterprise by going to https://tripwire/. 1377 
15. Log in to the Tripwire Enterprise Console.  1378 

 1379 
16. Click Settings. 1380 
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 1381 
17. Go to System > Log Management. 1382 
18. Check the box next to Forward TE log messages to syslog. 1383 
19. Enter the IP address and port of the Tripwire Log Center server. The default port is 1468.  1384 
20. Check the box next to Allow TE to use information from Tripwire Log Center. 1385 
21. Enter the service address like this: https://192.168.50.44:8091/tlc, replacing the IP address with 1386 

the IP address of the Tripwire Log Center server. 1387 
22. Enter the account information for the account created with the Databases and API permissions. 1388 

 1389 
23. Click Apply. 1390 
24. Click OK. 1391 
25. Go back to the Tripwire Log Center Console. 1392 
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 1393 
26. Click Configuration Manager. 1394 

 1395 
27. Click Resources > Tripwire Enterprise Servers. 1396 
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 1397 
28. Click Add. 1398 
29. Enter a name for the Tripwire Enterprise server.  1399 
30. Enter the IP address and port for the Tripwire Enterprise server. By default, Tripwire Log Center 1400 

and Tripwire Enterprise will communicate on port 443. (https://192.168.50.43) 1401 
31. Enter the name of a user account on the Tripwire Enterprise server. The account must have the 1402 

following permissions: create, delete, link, load, update, view. 1403 

 1404 
32. Click Save. 1405 
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2.11  Integration: Tripwire Log Center (TLC) and HPE ArcSight ESM 1406 

In this section is a process for integrating Tripwire Log Center and HPE ArcSight ESM. This integration 1407 
assumes the correct implementation of Tripwire and ArcSight as described in earlier sections. The result 1408 
of this integration is the forwarding of logs generated by Tripwire Enterprise to ArcSight ESM as well as a 1409 
method for filtering specifically for file change events in ArcSight ESM.  1410 

2.11.1  Integrating TLC and ESM 1411 
1. Run ArcSight-7.4.0.7963.0-Connector-Win64 on any Windows server (except for the server 1412 

running the Tripwire Log Center).  1413 

 1414 
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 1415 
2. Click Next. 1416 
3. Specify a folder to install the connector. 1417 

 1418 
4. Click Next. 1419 
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 1420 
5. Click Next. 1421 
6. Click Install.  1422 
7. Select Add a Connector. 1423 
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 1424 
8. Click Next.  1425 
9. Select Syslog daemon. 1426 
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 1427 
10. Click Next.  1428 
11. Select a port for the daemon to run on.  1429 
12. Leave IP address as (ALL). 1430 
13. Select Raw TCP for Protocol.  1431 
14. Select False for Forwarder. 1432 
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 1433 
15. Click Next. 1434 
16. Choose ArcSight Manager (encrypted). 1435 
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 1436 
17. Click Next. 1437 
18. For Manager Hostname, put vm-esm691c or the hostname of your ESM server. 1438 
19. For Manager Port, put 8443 (or the port that ESM is running on). 1439 
20. Enter the username and password used for logging into ArcSight Command Center. Default: 1440 

(admin/password) 1441 
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 1442 
21. Click Next. 1443 
22. Set identifying details about the system to help identify the connector (include Name; the rest is 1444 

optional). 1445 
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 1446 
23. Click Next. 1447 
24. Select Import the certificate to connector from destination. This will fail if the Manager 1448 

Hostname does not match the hostname of the VM. 1449 
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 1450 
25. Click Next. 1451 
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 1452 
26. Click Next. 1453 
27. Choose Install as a service. 1454 
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 1455 
28. Click Next.  1456 
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 1457 
29. Click Next.  1458 
30. Choose Exit. 1459 
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 1460 
31. Click Next.  1461 

 1462 
32. Click Done. 1463 
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33. Open Task Manager. 1464 
34. Click More Details. 1465 
35. Go to the Services tab. 1466 
36. Find the service just created for ArcSight and right click it. 1467 

 1468 
37. Choose Start. 1469 
38. Open the Tripwire Log Center Console.  1470 
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 1471 
39. Go to the Configuration Manager. 1472 
40. Select Resources > Managers. 1473 

 1474 
41. Double click the Primary Manager listed.  1475 
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 1476 
42. Click the Advanced Settings tab.  1477 
43. Click the +Add button. This should add a row to the table. 1478 
44. In the Advanced Option box, select Log Message Forwarding - Destinations.  1479 
45. In the Value box next to it, type <ip_address>:<port>:udp, with the IP Address and port of the 1480 

syslog daemon just created.  1481 

2.11.2  Configuring Tripwire Enterprise and HPE ArcSight ESM to Detect and Report 1482 
File Integrity Events 1483 

2.11.2.1  Creating a Rule for Which Files to Monitor Across Your Enterprise 1484 

1. Log into Tripwire Enterprise by going to https://tripwire and entering the user name and 1485 
password.  1486 

2. Click the Rules link. 1487 
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 1488 
3. Click New Rule. 1489 
4. Select Types > File Server > Windows File System Rule. 1490 

 1491 
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5. Click OK.  1492 
6. Enter a name for the rule.  1493 

 1494 
7. Click Next. 1495 

 1496 
8. Click New Start Point. This will bring up a New Start Point Wizard. 1497 
9. Enter the path to a folder or file that will be monitored across all Windows Systems. For 1498 

example, we chose to monitor C:\Users. 1499 
10. If you selected a directory and want the integrity check to recurse in all sub directories, make 1500 

sure the box next to Recurse directory is checked.  1501 
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 1502 
11. Click Next. 1503 
12. Select Windows Content and Permissions. 1504 

 1505 
13. Click Next.  1506 
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 1507 
14. Click Finish. 1508 
15. If you wish to exclude directories, click New Stop Point.  1509 

 1510 
16. Enter the path name of directories you wish to exclude. For example, we chose to exclude 1511 

C:\Users\*\AppData because that provided many false flags of routine application data 1512 
modification. 1513 

17. Check the box next to Stop Recursion. 1514 
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 1515 
18. Click Finish.  1516 
19. The rule created defines a space for the tasks we will create to search through. 1517 

2.11.2.2  Creating a Baseline Task 1518 

1. Click the Tasks link. 1519 

 1520 
2. Click New Task.  1521 
3. Select Baseline Rule Task. 1522 
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 1523 
4. Click OK. 1524 
5. Enter a name for the baseline rule task.  1525 
6. Select a privileged user in Tripwire Enterprise to run the rule as.  1526 

 1527 
7. Click Next. 1528 
8. Select All Baselines. 1529 
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 1530 
9. Click Next. 1531 
10. Expand Root Node Group > Smart Node Groups > System Tag Sets > Operating System. 1532 
11. You can select specific types of operating systems to run the task on or specific machines. We 1533 

simply selected Operating System to have it run on all applicable Windows machines. 1534 

 1535 
12. Once you have made your selection, click Next.  1536 
13. Select Selected nodes with rule or rule group. 1537 
14. Click the rule you created earlier. 1538 
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 1539 
15. Click Next.  1540 
16. Decide how often the baseline task should be run. We set it to manually but you can also set a 1541 

very specific schedule by choosing periodic.  1542 

 1543 
17. Click Finish. 1544 
18. This rule will create baselines of the specified objects. Baselines are essentially versions of the 1545 

file that check rules will compare against. Baselines should be primarily taken when the integrity 1546 
of files are known to be good.  1547 

2.11.2.3  Creating a Syslog Action 1548 

1. Click the Actions link. 1549 
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 1550 
2. Click New Action.  1551 
3. Select Syslog Action. 1552 

 1553 
4. Click OK. 1554 
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5. Enter a name for the Syslog Action.  1555 

 1556 
6. Click Next.  1557 
7. Enter the IP address of the Tripwire Log Center server.  1558 
8. Enter the port that Tripwire Log Center receives TCP syslog messages on. 1559 
9. Enter a log name, a level, and a facility code per your needs. These will show up in logs, so you 1560 

can use these to help separate or identify log sources. 1561 

 1562 
10. Click Finish. 1563 

2.11.2.4  Creating a Check Task 1564 

1. Click the Tasks link. 1565 
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 1566 
2. Click New Task.  1567 
3. Select Check Rule Task. 1568 

 1569 
4. Click OK. 1570 
5. Enter a name for the baseline rule task. 1571 
6. Select a privileged user in Tripwire Enterprise to run the rule as.  1572 
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 1573 
7. Click Next. 1574 
8. Expand Root Node Group > Smart Node Groups > System Tag Sets > Operating System. 1575 
9. Here, you can select specific types of operating systems to run the task on or specific machines. 1576 

We simply selected Operating System to have it run on all applicable Windows machines. 1577 

 1578 
10. Once you have made your selection, click Next.  1579 
11. Select Selected nodes with rule or rule group. 1580 
12. Click the rule you created earlier.  1581 
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 1582 
13. Click Next.  1583 
14. Decide how often the check task should be run. We set it to manually, but you can also set a 1584 

very specific schedule by choosing periodic.  1585 

 1586 
15. Click Next. 1587 
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 1588 
16. Click Add. 1589 
17. Select the Syslog Action created earlier. 1590 

 1591 
18. Click OK. 1592 
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 1593 
19. Click Next. 1594 
20. Uncheck the box next to initialize baselines now if you do not wish to immediately take a 1595 

baseline of all systems. 1596 

 1597 
21. Click Finish. 1598 
22. This rule will check the current versions of the selected files against their baselines and log any 1599 

changes to Tripwire Log Center.  1600 

2.11.2.5  Running the Baseline Task 1601 

1. Check the box next to the baseline task you created earlier. 1602 
2. Click Control > Run on the taskbar.  1603 
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3. Wait for the run to finish. You can click the Log link to see the progress.  1604 
4. When it finishes, it will log a message such as “Task 'Baseline Rule Windows' was completed in 1605 

600 seconds.” 1606 

2.11.2.6  Make Changes to Monitored Objects 1607 

1. Open a machine being monitored by the rule you created. 1608 
2. Modify a file or files in the folder that you selected in the rule creation wizard (which are being 1609 

monitored by Tripwire). 1610 

2.11.2.7  Running the Check Task 1611 

1. Check the box next to the check task you created earlier. 1612 
2. Click Control > Run on the taskbar. 1613 
3. Wait for the run to finish. You can click the Log link to see the progress. 1614 
4. If you made changes to a monitored object, the log message should appear at the time the 1615 

changes were made even if the change was made prior to the scan. 1616 

2.11.2.8  Filtering for Tripwire Enterprise Integrity Events in HPE ArcSight ESM 1617 

1. Open the ArcSight ESM machine.  1618 
2. Log in by going to https://vm-esm691c:8443 and entering your username/password.  1619 

 1620 
3. Click Events > Active Channels. 1621 
4. Click New.  1622 
5. Enter a name for the channel. Select a start time to show events, and leave $NOW as the end 1623 

time. 1624 
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 1625 
6. Click Configure Filter.  1626 

 1627 
7. Click the button that says Configure a condition using field. 1628 
8. Double click Device Event Category. 1629 
9. For Operator, choose Contains.  1630 
10. For Value, enter Audit Event.  1631 

 1632 
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11. Click Apply Condition. 1633 
12. Click Update Filter Configuration under the list of fields. 1634 

 1635 
13. Click Save Channel. 1636 
14. Click the channel you just created. It should show all file changes in the time frame you 1637 

specified forwarded from Tripwire Enterprise to Tripwire Log Center to ArcSight ESM. 1638 

2.12  Integration: HPE ArcSight ESM with Veeam and Hyper-V 1639 

This section covers the process for integrating HPE ArcSight ESM with Veeam and Hyper-V. This 1640 
integration assumes the correct implementation of Veeam and ArcSight as described in earlier sections. 1641 
The result is the forwarding of logs generated by Veeam and Hyper-V to ArcSight ESM, as well as custom 1642 
parsers to supplement the information provided by this forwarding process. 1643 

2.12.1  Install ArcSight Connector 1644 
1. Run the installation file ArcSight-7.4.0.7963.0-Connector-Win64 on the Veeam Server. 1645 

 1646 
2. Wait for the initial setup to finish. 1647 
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 1648 
3. Click Next. 1649 
4. Choose a destination folder. Note: It is recommended to change the default to 1650 

<default>\HYPERV so that other installed connectors do not overwrite this one. 1651 

 1652 
5. Click Next. 1653 
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 1654 
6. Click Next. 1655 

 1656 
7. Click Install. 1657 
8. Wait for the installation to finish. 1658 
9. Select Add a Connector. 1659 
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 1660 
10. Click Next. 1661 
11. Choose Microsoft Windows Event Log - Native from the list. 1662 
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 1663 
12. Click Next. 1664 
13. Check Security log, System log, Application Log, and Custom Log. 1665 
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 1666 
14. Click Next. 1667 
15. Click on the box underneath Custom Event Logs.  1668 
16. Enter Veeam Backup, Microsoft-Windows-Hyper-V-VMMS-Admin, Microsoft-Windows-1669 

Hyper-V-Integration-Admin, Microsoft-Windows-Hyper-V-SynthNic-Admin, Microsoft-1670 
Windows-Hyper-V-Worker-Admin. 1671 

 1672 
17. You can add more application logs through the following process: 1673 

a. Open Microsoft Event Viewer. 1674 
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 1675 
b. Find the log you wish to add. 1676 

 1677 
c. Open the Details pane of a log and find the field Channel. 1678 
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 1679 
d. Note that this may differ from the Log Name in the General pane. (For example, one of 1680 

the Hyper-V log's Log Name is Microsoft-Windows-Hyper-V-VMMS/Admin but the 1681 
channel name is Microsoft-Windows-Hyper-V-VMMS-Admin.) 1682 

e. Enter all these channel names separated by commas in the Custom Event Logs field. 1683 
18. Click Next. 1684 
19. Choose ArcSight Manager (encrypted). 1685 

 1686 
20. Click Next. 1687 
21. For Manager Hostname, put vm-esm691c, or the hostname of your ESM server. 1688 
22. For Manager Port, put 8443, or the port that ESM is running on, on the ESM server. 1689 
23. Enter the username and password used for logging into ArcSight Command Center 1690 

(admin/password). 1691 
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 1692 
24. Click Next. 1693 
25. Set identifying details about the system to help identify the connector (include at least Name; 1694 

the rest is optional). 1695 

 1696 
26. Click Next. 1697 
27. Select Import the certificate to connector from destination. This will fail if the Manager 1698 

Hostname does not match the hostname of the VM. 1699 
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 1700 
28. Click Next. 1701 
29. Wait for the process to complete. 1702 

 1703 
30. Click Next. 1704 
31. Choose Install as a service. 1705 
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 1706 
32. Click Next.  1707 

 1708 
33. Click Next. 1709 
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 1710 
34. Click Next.  1711 
35. Choose Exit. 1712 
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 1713 
36. Click Next.  1714 

 1715 
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37. Click Done. 1716 
38. Open Task Manager. 1717 
39. Click More Details. 1718 

 1719 
40. Go to the Services tab. 1720 
41. Find the service just created arc_winc for ArcSight, and right click it. 1721 
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 1722 
42. Choose Start. 1723 
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 1724 
43. The machine will now report its logs to ArcSight ESM. 1725 
44. For more fine-grained reporting, such as including more information about the event, you may 1726 

wish to include custom parsers that are described below. 1727 

2.12.2  Create a Parser for Veeam Logs 1728 
1. For a Veeam custom parser that handles event numbers 210, 251, and 290, create a 1729 

configuration file with the following text: 1730 

trigger.node.location=/EventData 1731 

event.deviceVendor=__getVendor("Veeam") 1732 

conditionalmap.count=1 1733 

conditionalmap[0].field=event.externalId 1734 

conditionalmap[0].mappings.count=3 1735 

conditionalmap[0].mappings[0].values=210 1736 

conditionalmap[0].mappings[0].event.name=__stringConstant("Restore session 1737 
initiated.") 1738 
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conditionalmap[0].mappings[1].values=251 1739 

conditionalmap[0].mappings[1].event.name=__stringConstant("Restore session 1740 
has finished with success state.") 1741 

conditionalmap[0].mappings[2].values=290 1742 

conditionalmap[0].mappings[2].event.name=__stringConstant("Restore session 1743 
has finished with success state.") 1744 

 1745 
2. Save this file as C:\Program Files\ArcSightSmartConnectors\<name of 1746 

folder>\current\user\agent\fcp\winc\veeam_backup\veeam_mp.sdkkeyvaluefilereader.propert1747 
ies 1748 

 1749 
3. Copy this file to C:\Program Files\ArcSightSmartConnectors\<name of 1750 

folder>\current\user\agent\winc\veeam_backup\veeam_mp.sdkkeyvaluefilereader.properties 1751 
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 1752 

2.12.3  Create a Parser for Hyper-V Logs 1753 
1. For a Hyper-V VMMS custom parser, create a configuration file with the following text: 1754 

trigger.node.location=/EventData 1755 

event.deviceVendor=__getVendor("Microsoft") 1756 

token.count=1 1757 

token[0].name=VmName 1758 

token[0].location=VmlEventLog/VmName 1759 

token[0].type=String 1760 

conditionalmap.count=1 1761 

conditionalmap[0].field=event.externalId 1762 

conditionalmap[0].mappings.count=1 1763 

conditionalmap[0].mappings[0].values=13003 1764 

conditionalmap[0].mappings[0].event.name=__concatenate(__stringConstant("The 1765 
virtual machine '"), VmName, __stringConstant("' has been deleted.")) 1766 
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 1767 
2. Save this file as C:\Program Files\ArcSightSmartConnectors\<name of 1768 

folder>\current\user\agent\fcp\winc\microsoft_windows_hyper_v_vmms_admin\microsoft_wi1769 
ndows_hyper_v_vmms.userdata.jsonparser.properties 1770 

 1771 
3. Copy this file to C:\Program Files\ArcSightSmartConnectors\<name of 1772 

folder>\current\user\agent\winc\microsoft_windows_hyper_v_vmms_admin\microsoft_windo1773 
ws_hyper_v_vmms.userdata.jsonparser.properties 1774 
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 1775 

These two parsers will allow for details of VM deletions and VM restores to be shown in ArcSight. 1776 
Custom parsers are a functionality of ArcSight. For more information on the creation of custom parsers, 1777 
please see the ArcSight FlexConnector Developer's Guide, as well as the SmartConnector for Microsoft 1778 
Windows Event Log - Native, Configuration Guide (for information specific to Windows event logs). 1779 

2.13  Integration: GreenTec WORMdisks and IBM Spectrum Protect 1780 

This section covers the process for integrating IBM Spectrum Protect and GreenTec WORMdisks. The 1781 
result is the capability to backup clients directly to WORMdisks in order to preserve data more securely. 1782 
This integration process does not include instructions related to locking the WORMdisks – that process is 1783 
found in the GT_WinStatus User Guide, that should accompany the installation disk. Scheduling the 1784 
locking of these disks is left up to the discretion of the adapting organization. 1785 

2.13.1  Install IBM Spectrum Protect Server on the GreenTec Server 1786 
1. You may need to disable Run all administrators in Admin Approval Mode. To do this go to 1787 

Control Panel > Administrative Tools > Local Security Policy > Local Policies > Security 1788 
Options. Double click the User Account Control: Run all administrators in Admin Approval 1789 
Mode section. Select Disable and click OK. Restart the computer. 1790 
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 1791 

 1792 
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 1793 

 1794 
2. Run WIN_SER_STG_ML in its own folder to extract the contents. 1795 
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 1796 
3. Run the install script.  1797 

 1798 
4. Make sure all the boxes are checked. 1799 
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 1800 
5. Click Next.  1801 
6. Read and select I accept the terms in the license agreement. 1802 

 1803 



DRAFT 

NIST SP 1800-11C: Data Integrity  300 

7. Click Next.  1804 
8. Select the installation location for files. 1805 

 1806 
9. Click Next. 1807 
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 1808 
10. Click Next. 1809 
11. Make sure all the packages are checked.  1810 

 1811 
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12. Click Next. 1812 
13. Select IBM Spectrum Protect. 1813 

 1814 
14. Click Next.  1815 
15. Read and select I accept the terms in the license agreement. 1816 
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 1817 
16. Click Next.  1818 
17. Read and select I accept the terms in the license agreement. 1819 

 1820 
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18. Click Next. 1821 
19. Specify 11090 for the port.  1822 

 1823 
20. Click Next.  1824 
21. Select Strict for the SP800-131a Compliance. 1825 



DRAFT 

NIST SP 1800-11C: Data Integrity  305 

 1826 
22. Click Next.  1827 
23. Create a password. 1828 

 1829 
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24. Click Next.  1830 

 1831 
25. Click Install. 1832 
26. After the successful installation, click Finish. 1833 

2.13.2  Configure IBM Spectrum Protect 1834 
1. Go to Start > IBM Spectrum Protect Configuration Wizard. 1835 
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 1836 
2. Click OK. 1837 

 1838 
3. Click Next. 1839 
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4. Specify a name and an account for the IBM server to use. Example: (name: GRNBACK, User ID: 1840 
DI\sp_admin) 1841 

 1842 
5. Click Next. 1843 
6. Choose a directory. 1844 
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 1845 
7. Click Next. 1846 
8. Click Yes if prompted to create the directory. 1847 
9. Choose The database directories are listed below. 1848 
10. Create a directory to contain the database. Example: C:\BACKSERV\IBMBackupServer. 1849 
11. Enter the directory in the space provided. 1850 
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 1851 
12. Click Next. 1852 
13. Create directories for logs and archive logs. Example: C:\BACKSERV\IBMBackupServerLogs, 1853 

C:\BACKSERV\IBMBackupServerArchiveLogs. 1854 
14. Enter the directories in their respective fields. 1855 
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 1856 
15. Click Next. 1857 
16. Specify the server name.  1858 
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 1859 
17. Click Next. 1860 
18. Specify an Administrator account. 1861 

 1862 
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19. Click Next.  1863 
20. Select a port (example: 1500). 1864 
21. Check the box next to Enable SSL Communication and enter a port (example: 23444). 1865 

 1866 
22. Click Next. 1867 
23. Click Next.  1868 
24. Wait for the installation to finish. 1869 
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 1870 
25. Click Next. 1871 
26. Click Done. 1872 
27. Log in to Operations Center by going to localhost:11090/oc/. 1873 
28. Log in using the credentials provided in the Configuration Wizard. 1874 

 1875 
29. Enter the password for a new account to be created on the system. 1876 
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 1877 
30. Click Next. 1878 
31. Select the time interval for data collection. 1879 

 1880 
32. Click Next. 1881 
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33. Select time intervals that suit your organization's needs. 1882 

 1883 
34. Click Configure. 1884 

 1885 
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2.13.3  Connect the GreenTec Server to the IBM Spectrum Protect Server 1886 
1. Go back to the primary IBM server. 1887 

 1888 
2. Click Servers. 1889 

 1890 
3. Click +Spoke. 1891 
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 1892 
4. Enter the IP address of the server with GreenTec disks attached. 1893 
5. Enter the port that the server is configured to listen for connections on (Example: 1500). 1894 
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 1895 
6. Click Next. 1896 
7. Enter the password for the new server twice.  1897 
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 1898 
8. Click Next. 1899 

 1900 
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9. Click Connect Spoke. 1901 

 1902 
10. Click Close.  1903 

2.13.4  Define a Volume on the GreenTec Server 1904 
1. Issue the following command in the Operations Center (on the GreenTec server) command 1905 

builder to create a device class for the backup disk (replace the name golden, max capacity 1906 
value, and directory value as you see fit).  1907 
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 1908 
> define devclass golden devtype=file maxcapacity=350000M shared=yes 1909 
mountlimit=1 directory="E:\" library=backuplib  1910 

 1911 
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2. Go to Storage > Storage Pools. 1912 

 1913 
3. Click +Storage Pool. 1914 
4. Enter a name.  1915 

 1916 
5. Click Next. 1917 
6. Select Disk (primary). 1918 
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 1919 
7. Click Next.  1920 
8. Select the device class you just created.  1921 

 1922 
9. Click Next.  1923 
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 1924 
10. Click Next.  1925 

 1926 
11. Click Add Storage Pool. 1927 
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 1928 
12. Click Close & View Policies. 1929 
13. Issue the following command in the Operations Center command builder to create a volume on 1930 

the backup disk.  1931 
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define volume goldenstg golden1 location="E:\" formatsize=350000 1932 
access=readwrite numberofvolumes=1 wait=no1933 

 1934 
14. The storage pool may indicate that there is no capacity, but once you backup something it 1935 

should correctly show the capacity.  1936 

2.13.5  Create a Policy to Backup to GreenTec disks 1937 
1. Issue the following command in the Operations Center (on the GreenTec server) command 1938 

builder to delete the standard policy domain: 1939 

delete domain standard 1940 

2. Issue the following command to create a new domain. 1941 
define domain golden 1942 

3. Issue the following command to create a new policy set in this domain. 1943 
define policyset goldenpolicy 1944 

4. Issue the following command to create a management class in this domain. 1945 
define mgmtclass golden goldenpolicy goldenclass 1946 
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 1947 

5. Click Services > Policy Sets. 1948 
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 1949 
6. Toggle the Configure button. This should allow you to edit the settings of the newly created 1950 

management class. 1951 
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 1952 
7. Select Default.  1953 
8. For Backup Destination, select the storage pool you just created.  1954 
9. For Backups, select 1.  1955 
10. Select the rest of the settings per your organization's needs. 1956 
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 1957 
11. Click the Activate button.  1958 
12. Check the box next to I understand that these updates can cause data deletion. 1959 

 1960 
13. Click Activate. 1961 
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2.13.6  Create a Schedule That Uses the New Policy 1962 
1. On the primary IBM Spectrum Protect Server log in to the Operations Center. 1963 

 1964 
2. Go to Clients > Schedules. 1965 

 1966 
3. Click +Schedule. 1967 
4. Enter a name for the schedule. 1968 
5. For Server, select the GreenTec server. 1969 
6. For Domain, select the policy domain you just created. 1970 
7. For Type, select System. 1971 
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 1972 
8. Click Next. 1973 
9. Select Daily incremental backup.  1974 
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 1975 
10. Click Next. 1976 
11. Configure the schedule settings for your organization's needs. This can be changed later. 1977 
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 1978 
12. Click Add Schedule. 1979 
13. From the command builder, run the following command to update the schedule: 1980 

update schedule golden golden starttime=now action=backup type=client 1981 
objects="c:\*" startdate=06/10/2017 perunits=onetime 1982 

2.13.7  Installing Open File Support on the Client  1983 
1. Open the client machine (with the IBM Backup Archive Client installed) to make a golden disk.  1984 
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 1985 
2. Open the IBM BA Client. 1986 
3. Click Utilities > Setup Wizard.  1987 
4. Check the box next to Help me configure Open File Support. 1988 

 1989 
5. Click Next. 1990 
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 1991 
6. Click Next.  1992 
7. Select Volume Shadowcopy Services (VSS). 1993 

 1994 
8. Click Next.  1995 
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 1996 
9. Click Apply.  1997 

 1998 
10. Click Finish.  1999 
11. Restart the BA Client. 2000 
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 2001 
12. Click Edit > Client Preferences. 2002 
13. Click the Include-Exclude tab.  2003 

 2004 
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14. Click Add.  2005 
15. For Category, select Backup. 2006 
16. For Type, select Include.FS. 2007 
17. For Snapshot Provider Type, choose VSS.  2008 
18. For File or Pattern, enter *:\*.  2009 

 2010 
19. Click OK.  2011 

2.13.8  Temporarily Add Client to GreenTec IBM Server 2012 
1. Assuming your GreenTec disks are on a separate IBM server, you will need to connect the client 2013 

you wish to migrate in order to use the created schedule. On the GreenTec server, click Clients. 2014 

 2015 
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2. Click +Client. 2016 
3. Select the GreenTec server.  2017 

 2018 
4. Click Next.  2019 
5. Enter the information for the client you are migrating to this server. 2020 

 2021 
6. Click Next. 2022 
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7. Take note of the information presented here, namely the IP and port provided, as you will need 2023 
it on the client machine to connect to the server. 2024 

 2025 
8. Click Next.  2026 
9. Select the policy domain you created. 2027 

 2028 
10. Click Next. 2029 
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11. Select the schedule created earlier.  2030 

 2031 
12. Click Next.  2032 

 2033 
13. Click Next. 2034 
14. Select the at-risk options per your organization's needs. 2035 
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 2036 
15. Click Add Client.  2037 

 2038 
16. Click Close. 2039 
17. On the client machine, open the BA client.  2040 
18. Click Edit > Client Preferences. 2041 
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19. Click the Communication tab, and enter the new server address and port. Only leave Use SSL 2042 
checked if you have set it up for this new server. Similarly, unselect SSL is required if you did not 2043 
setup SSL on this second server. 2044 

 2045 
20. Restart the BA client. The client should now connect to the new server. 2046 
21. You may be prompted for a password. Enter the password and press Enter.  2047 
22. To start the schedule, issue the following command in the Operations Center command builder: 2048 

 update schedule golden golden startdate=today starttime=now 2049 

2.14  Integration: Backing Up and Restoring System State with GreenTec 2050 

This section covers the process for backing up (and restoring) the Windows System State on a Windows 2051 
Server with GreenTec as a backup medium. The backup of user information as well as other system state 2052 
information to a networked GreenTec WORMdisk is intended for the recovery of damage to the 2053 
Windows system state, such as account permission modification, account creation, account deletion, 2054 
and various other applicable scenarios. 2055 
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2.14.1  Installing Windows Server Essentials for System State Backup Capability 2056 
(NOTE: For older machines, IBM Spectrum Protect's option to backup SystemState may be sufficient. 2057 
However, for newer, more complex versions of Windows, such as Windows Server 2012 and Windows 2058 
8+, you should use the following procedure.) 2059 

1. Open Server Manager. 2060 

 2061 
2. Select Manage > Add Roles and Features. 2062 

 2063 
3. Click Next.  2064 
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4. Select Role-based or feature-based installation. 2065 

 2066 
5. Click Next. 2067 
6. Select the server. 2068 

 2069 
7. Click Next. 2070 
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8. Select Windows Server Essentials Experience. 2071 

 2072 
9. Click Next.  2073 

 2074 
10. Click Next. 2075 
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 2076 
11. Click Next. 2077 
12. Click Install.  2078 

 2079 
13. Click Configure Windows Server Essentials Experience.  2080 
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 2081 
14. Click Configure. 2082 

 2083 
15. Click Close. 2084 
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2.14.2  Configure Network Accessible GreenTec Disk 2085 
1. To configure a GreenTec disk to be network accessible, right click the disk on the GreenTec 2086 

server.  2087 

 2088 
2. Click Share With > Advanced Sharing.  2089 
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 2090 
3. Click Advanced Sharing.  2091 
4. Check the box next to Share this folder. 2092 
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 2093 
5. Click OK.  2094 
6. Click Close. 2095 

2.14.3  Backup the System State 2096 
1. Go to command prompt on the Active Directory server and enter the following command: 2097 

  wbadmin start systemstatebackup -backuptarget:z: 2098 
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  2099 

 (Instead of z:, put the location of a disk for the system state backup. You will get an error if you 2100 
attempt to use the same location as the disc you are trying to backup. Examples of acceptable targets: 2101 
C:, Z:, \\backup-storage\g) 2102 

  2103 

2.14.4  Restoring the System State 2104 
1. After determining the point in time of a malicious event, restart the Active Directory Server and 2105 

press F2 > F8 to start the Advanced Boot menu.  2106 
2. Select Directory Services Repair Mode.  2107 
3. Log in as the machine administrator. 2108 
4. Open a command prompt. 2109 
5. Enter the following command to see the backup versions available: 2110 

wbadmin get versions 2111 
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  2112 

6. Enter the following command to restore to a specific version (preferably before the malicious 2113 
event occurred):  2114 

 wbadmin start systemstaterecovery -version:06/21/2017-15:33 -2115 
backupTarget:\\192.168.52.12\g 2116 

(Replace the backupTarget with the location of the backup, and the version with the version to 2117 
restore to.) 2118 

  2119 

7. The computer will restart when you finish the restore process. 2120 

2.15  Integration: Copying IBM Backup Data to GreenTec WORMdisks 2121 

This section covers the process for integrating IBM Spectrum Protect with GreenTec WORMDisks. This 2122 
integration assumes the correct implementation of IBM Spectrum Protect, as well as the existence of 2123 
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GreenTec WORMdisks as described in earlier sections. The result of this integration is the capability to 2124 
store all backup data created by IBM Spectrum Protect for a single client on a secure WORMDisk. 2125 

2.15.1  Copying Backups for a Single Machine to a GreenTec WORMDisk 2126 
1. On the IBM Spectrum Protect server, log on to IBM Spectrum Protect Operations Center. 2127 
2. Create a new device class by running the following command in the Command Builder: 2128 

define devclass backupset devtype=file maxcapacity=100000M shared=yes 2129 
mountlimit=1 directory="C:\" 2130 

 2131 
3. Go to Storage > Storage Pools. 2132 

 2133 
4. Click +Storage Pool. 2134 
5. Enter a name.  2135 
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 2136 
6. Click Next. 2137 
7. Select Disk (primary). 2138 

 2139 
8. Click Next.  2140 
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 2141 
9. Click Next. 2142 

 2143 
10. Click Add Storage Pool. 2144 
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 2145 
11. Create a backup set for the client whose data you wish to store securely. Run the following 2146 

command on Command Builder: 2147 

generate backupset <name of client> <identifier> \\<name of client>\c$ 2148 
devclass=file volumes=backupset1 nametype=unicode 2149 

 For example: 2150 

generate backupset windowsvm1 windowsvm1_backupset \\windowsvm1\c$ 2151 
devclass=file volumes=backupset1 nametype=Unicode 2152 
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  2153 

12. This will store all backup data for the client WINDOWSVM1 in a file called backupset1. You can 2154 
copy this file to a GreenTec disk and store for later use.  2155 

2.16  Integration: Tripwire and MS SQL Server 2156 

This section covers the process for integrating Tripwire Log Center and Microsoft SQL Server. This 2157 
integration assumes the correct implementation of Tripwire as described in earlier sections. The result 2158 
of this integration is the collection of database audit logs in Tripwire, allowing for detection and 2159 
reporting of events such as specific types of queries, schema modification, and database modification. 2160 

2.16.1  Create a New Account on MS SQL Server 2161 
1. Open SQL Server Management Studio. 2162 
2. Hit Connect to connect to the database. 2163 
3. In the Object Explorer window, expand the Security folder. 2164 
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 2165 
4. Right click on the Logins folder and click New Login…. 2166 
5. Input the desired user. 2167 
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 2168 
6. Click User Mapping. 2169 
7. For each database that Tripwire should monitor, click the database and assign the role 2170 

db_datareader. 2171 
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 2172 
8. Click Securables. 2173 
9. Under the Grant column, check the boxes next to Alter trace and View any definition (if this is 2174 

not available, create the user, then edit properties for that user). 2175 
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 2176 
10. Click OK. 2177 

2.16.2  Create a New Audit on MS SQL Server 2178 
1. In the Object Explorer window, expand the Security folder. 2179 
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 2180 
2. Right click on the Audits folder. 2181 
3. Click New Audit…. 2182 
4. Specify a filename or any other settings per your organization’s needs. Note: If you specify a 2183 

filename, you will be able to view any queries you wish to monitor in this Audit log, but not in 2184 
Tripwire. However, if you set the Audit Destination to Application Log, the messages will be 2185 
forwarded to the Microsoft Application Log. This will result in less structured (but still detailed) 2186 
messages and allows the capability to collect them easily using HPE ArcSight ESM. If your 2187 
ArcSight Connector is configured to collect Application Logs from the MS SQL server, no further 2188 
configuration of the connector is required. 2189 
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 2190 
5. Click OK.  2191 
6. Right click Security > Server Audit Specifications. 2192 
7. Click New Server Audit Specification…. 2193 
8. For Audit: select the audit you just created. 2194 
9. Specify any Audit Action Types that Tripwire should be able to log. 2195 
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 2196 
10. Click OK. 2197 
11. Open a database that you wish to monitor specific objects in. 2198 
12. Right click Databases > <Database name> > Security > Database Audit Specifications. 2199 
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 2200 
13. Click New Database Audit Specification….  2201 
14. Select an Audit Action Type to monitor. 2202 
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 2203 
15. Select Object for the Object Class.  2204 
16. In the Object Name field, use the Browse button to find objects that you wish to monitor for the 2205 

specified Audit Action Type. 2206 
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 2207 
17. Create as many types as you wish Tripwire to monitor. 2208 
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 2209 
18. Click OK. 2210 
19. Find the audits you just created in the Object Explorer and right click. 2211 
20. Select Enable ___ Audit Specification for each one.  2212 

2.16.3   Create a New Node for the MS SQL Server on Tripwire Enterprise 2213 
1. Open the Tripwire Enterprise console. 2214 
2. Click Nodes. 2215 
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 2216 
3. Click Manage > New Node. 2217 

 2218 
4. Click Types > Database Server > Microsoft SQL Server. 2219 
5. Click Ok. 2220 
6. Enter the hostname or IP of the MS SQL Server.  2221 
7. Enter the instance name of the database. 2222 



DRAFT 

NIST SP 1800-11C: Data Integrity  373 

 2223 
8. Click Next.  2224 
9. Enter the port the database listens on.  2225 

 2226 
10. Click Next. 2227 
11. Enter the newly created username and password for the database.  2228 
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 2229 
12. Click Next. 2230 
13. Check the box next to Collect audit-event information. 2231 

 2232 
14. Click Next.  2233 
15. Find the MSSQL Server on the list. 2234 
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 2235 
16. Click Next.  2236 
17. Test Login to ensure the information you entered was correct. 2237 

 2238 
18. Click Finish.   2239 
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Appendix A  List of Acronyms 2240 

AD Active Directory 2241 

BA  Client Backup-Archive Client 2242 

DB Database 2243 

DI Data Integrity 2244 

DNS Domain Name System 2245 

EOF End of File 2246 

ESM Enterprise Security Manager 2247 

HPE Hewlett Packard Enterprise 2248 

IP Internet Protocol 2249 

IT Information Technology  2250 

LDAP Lightweight Directory Access Protocol 2251 

MS SQL Microsoft Structured Query Language 2252 

NCCoE National Cybersecurity Center of Excellence  2253 

NIST National Institute of Standards and Technology 2254 

MS Microsoft 2255 

CA Certificate Authority 2256 

DSRM Directory Services Restore Mode  2257 

IIS Internet Information Services 2258 

IP  Internet Protocol 2259 

SQL Structured Query Language 2260 

SDK Software Development Kit 2261 

TCP  Transmission Control Protocol 2262 

SSL  Secure Sockets Layer 2263 

TLS  Transport Layer Security 2264 

VSS  Volume Shadowcopy Services 2265 
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VM Virtual Machines 2266 

VnE Vulnerability and Exposure 2267 

WORM Write Once Read Many 2268 
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